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Copyright

Trademarks

FCC Compliance

Copyright © 2013 Stratasys Ltd. All rights reserved.

This documentation contains proprietary information of Stratasys Ltd. This information is supplied
solely to assist authorized users of Objet1000 - Connex 2 3D printing systems. No part of this
document may be used for other purposes, and it may not be disclosed to other parties.

The specifications on which this document is based are subject to change without notice.

No part of this book may be reproduced in any form or by any means, nor stored in a database or
retrieval system, without prior permission in writing from Stratasys Ltd.

If this document is distributed as a PDF file, you may print it for internal use.

The following are registered trademarks of Stratasys Ltd.: Stratasys®, Objet®, FullCure®.

The following are trademarks of Stratasys Ltd.: Eden, Eden500V, Eden350V, Eden350, Eden330,
Eden260, Eden260V, Eden250, Connex, Connex500, Connex350, Objet30, Objet30-Pro, Objet30-
OrthoDesk, Objet30-Scholar, Objet24, Alaris, Alaris30, Poly]Jet, PolyJet Matrix, CADMatrix, PolyLog,
Objet Studio, Job Manager, SHR, Clear, Durus, DurusWhite, MED610, MED690, ObjetGreen,
RoseClear, TangoBlack, TangoBlackPlus, TangoGray, TangoPlus, VeroBlue, VeroGray, VeroWhite,
VeroWhitePlus, VeroBlack.

Microsoft and Microsoft XP are trademarks of Microsoft Corporation.

All names of products and services cited in this book are trademarks or registered trademarks of their
respective companies.

The equipment referred to in this guide has been tested and found to comply with the limits for a
Class A device pursuant to part 15 of the FCC rules. These limits provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. Objet 3D
printing systems generate, use and can radiate radio-frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference, in which case
the user will be required to correct the interference at his own expense.

The 3D printer referred to in this guide contains a transmitter module, FCC ID YH6-XLRFID.

NOTE: Stratasys is not responsible for radio or TV interference caused by unauthorized modification
to this equipment. Such modification could void the user’s authority to operate the equipment.

Equipment Recycling

In the European Union, this symbol indicates that when the last user wishes to discard a product, it
must be sent to appropriate facilities for recovery and recycling. For information about proper
disposal, check your purchase contract, or contact the supplier of the equipment.

Limitation of Liability
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The product, software or services are being provided on an “as is” and “as available” basis. Except as
may be stated specifically in your contract, Stratasys Ltd. expressly disclaims all warranties of any
kind, whether express or implied, including, but not limited to, any implied warranties of
merchantability, fitness for a particular purpose and non-infringement.

You understand and agree that Stratasys Ltd. shall not be liable for any direct, indirect, incidental,
special, consequential or exemplary damages, including but not limited to, damages for loss of profits,
goodwill, use, data or other intangible losses (even if Stratasys has been advised of the possibility of
such damages), resulting from: (i) the use or the inability to use the product or software; (ii) the cost of
procurement of substitute goods and services resulting from any products, goods, data, software,
information or services purchased; (iii) unauthorized access to or alteration of your products, software
or data; (iv) statements or conduct of any third party; (v) any other matter relating to the product,
software, or services.

The text and drawings herein are for illustration and reference only. The specifications on which they
are based are subject to change. Stratasys Ltd. may, at any time and without notice, make changes to
this document. Stratasys Ltd., for itself and on behalf of its subsidiaries, assumes no liability for
technical or editorial errors or omissions made herein, and shall not be liable for incidental,
consequential, indirect, or special damages, including, without limitation, loss of use, loss or alteration
of data, delays, or lost profits or savings arising from the use of this document.
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Patents

This product is covered by one or more of the following U.S. patents:
5,386,500
6,259,962
6,569,373
6,658,314
6,850,334
7,183,335
7,209,797
7,225,045
7,364,686
7,369,915
7,479,510
7,500,846
7,604,768
7,628,857
7,658,976
7,725,209

Stratasys Ltd.
http://www.stratasys.com

DOC-06800
Revision Rev. A
June 2013

q3

iv DRAFT
16 June 2013



Contents

1 About This Guide

UsINg This GUIAE .....ccooviiiiiiiii i s 1-2
FOT MOTe INfOIMMAtION.....c..iiietiiiiieteceteeeee ettt ettt ettt e eteeeeae e saeeereeeseeesesesseessensesenseenneeeens 1-2
Terms Used in ThiS GUIAE .....c.ccueiiierieieieceeeteeecteete ettt e e e teere e sae e esesrae s e seeanennnens 1-3
2 Safety
Safety FEAtUIes ........cccoviiiiiiiiii i e 2-2
Symbols and Warning Labels ..o 2-3
Safety GUIAELNES ... s 2-4
Printer INSTAllAation ......c.cc.ecieiiiieiieieiect ettt ettt et et et e et e s e b e e beessessesbesseessenseseessensasseeseas 2-4
Printer OPeration .........ocoeveieiiiiiiiiicccc s 2-4
UV RAAIAION 1.ttt ettt et et e te et ess s esbeeseessenbassesseessessesseessessassaseeseessessensessens 2-4
Printer MaINteNANCE ....cc.vveiieeciieeeee ettt eet e e e te e e ee e e svaeesabeeessaeessessaessaeeasseeasssaesssenneennes 24
Model and Support Materials ..........c.ooveiieirieieieiicceie s 2-5
First Aid for Working with Printing Materials...........ccccccoiiiirnnnniiicccceeeeeececenes 2-6
CONtACt WIHH SKIN....ouiiieiticceceeeeeeeee e ettt ettt e et et eeaeeseese e e eeaeeseesseneeteeneenean 2-6
Contact With BYeSs ........ccciiiiicc s 2-6
INESHION ...t e 2-6
TNNALAHON 1.ttt et e v et et e e te e bee e ateeateebe e be e beeebeeeaeeeteebeebe e teereereans 2-6
Waste DISPOSAL ..ot s 2-7

3 Introducing the Objet 3D Printing System

WELCOmME 0 COMMEX.......ouiuieiiiiiiiiiieiet ittt ettt s 3-2
WOTk Configurations.........ccocuviiiiiiiiiiiii s 3-3
SOULCE FILES ..o 34
STL FILES .ottt 34
SLC FILES .ot 34
ConnexX WOTKEIOWS ..o 3-5
Printing Materials ... s 3-6
SEOTAZE ...eeeeeeeetctet ettt 3-6
SRELE L ...ttt e 3-6
EXposure t0 LIgNt.........ooiii s 3-6
Safety Considerations...........cccciiueiiiiiniiiciic e 3-6
DHSPOSAL ...ttt s 3-7
WOrk ENVIFONIMIENT ......oiuiiiiiiiiiciiciiccc et et 3-7
Preparing Files for Use with Objet 3D Printing Systems............cccoeevviieiiiiiiniceeccene, 3-8
Converting CAD Files to STL FOrmat ..........ccoouoioiiiicieiieccce s 3-8
Converting Files to SLC FOImMaLt ........cccccouiiiiiiiiiiiiiiics s 3-8
Objet StUdIo SOFtWATE ......cciuiiiiii s 3-9

4 Installing Objet Software

How to Install Software for the Objet 3D Printing System..........coveeiiicncceeeeeeinecrccenens 4-2
How to Uninstall Objet StUdiO.......ccccviiiiiiiiiiiici s 4-5
DOC-06800 Rev. A DRAFT

16 June 2013



Objet1000 - Connex 2 User Guide

5 Using Objet Studio

Launching Objet StUAIO ........ccceviiiiiiiiiiiiiii s 5-3
Windows® 7 Security Warning ..ot 5-3
Objet Studio INLEIFACE ......c.vveiviiciiiici e 54
Ribbon COmMMANGS........coeuiiieiiiciiiecic s e 5-6
Objet Studio ComMmMAaNAs MeNU............cooviurieieiiiiciciee s 5-8
MOdel TTEE PANE.........cuviiiiece et 5-8

Preparing Models for Production............ccooiiiinininiiiicccnnens 5-9
OBJDF FIlES: OVEIVIEW ...cuvevieuieniiiieiieiesieetteseetesteeseeaessesseestsessessesssessessessesssessessessasssessassessesssessessenes 5-9
MOAEI FILES ... s 59
Placing Objects on the Build Tray .......cccooviiiviiiiiiiici e 5-10
Opening Objet Tray Files..........cccoooiviviiiiiiniiiiii s 5-14
Quick-Access Model COMMEANAS......covieeiirrieriierieirecereeetreeee et eteeereeereeereeeseeesseeseeesseeseseseeseessnees 5-16
Copying and Pasting ObJects...........cccoiiiiniiiiiiiiiic e 5-17
Selecting ODJECtS ........cuvuiieieiieecee s 5-18
Splitting Objects into COMPONENS .........c.oeueiiieiiiiciciee e 5-18
Model-Material SEttiNgGS ..........ocoeuiiiiiiiiicce s 5-20
Changing the Model Material.............ccooeiiiiiiiiiic e 5-21
Digital Materials .........ccccovviiiiiiiiiiiiiiiiiic e 5-21
Assigning a Model Material to ObJects ........coouoiiiciciiieiiccce 5-22
Surface FINISH ..o 5-23
CoatING ODJECES ......vviiiiiiii s 5-23
Assigning Properties to Hidden Objects..........ccccoiiiniiiiiiiiiiics 5-25

Positioning Objects on the Build Tray ........cccocoeoiiiiiiiiiiiiiiiiiccccc s 5-26
Automatic Orientation.........cceeiiiiiiiiicccc e 5-26
Automatic Placement.........cccoviiiiiininiiiiiii s 5-27
Manual POSIHONING .......ccovvviiiiiiiiiiii s 5-28

Model Orientation........cccviiiiiiiiiii e e 5-29

Manipulating Objects on the Build Tray ........cccccoeiiviniinniiiiiiiiiic s 5-30
Positioning Objects 0N the Z-AXiS.........ccceeeieiiiiiiieieiecccc e 5-30
Valid Object Placement ...........c.c.oviiuiuiieieiiiie it 5-31
Using a Grid to Position ODJeCcts ............coceuiiiieiiiiccieec e 5-32
Measurement UNItS..........c.oouiiiiiiii e 5-33
Setting Model DImeNSIONS ..........c.coveiiiuiicieieiccici e 5-34
Repositioning ODBJECtS ..ottt 5-34
Changing an Object’s Orientation..........cccccovviiiiiiniiiii s 5-36
Grouping and Ungrouping ObJECtS ... 5-37
Freezing Model Orientation............ccooiiiiiiiiiiiii s 5-38

Display OPHONS..... ..ottt 5-39
VIEWING ODJECES ..o 5-39
SCIEEN LAY OUL ...ttt 541
Tray PerSPECIVE ...ocveieiiiiitct e e 5-42
Setting Object COLOTS. ...ttt 5-43
Loading Large Files............ooirriiiiiiieccieieee et 5-44
Large File Manipulation ..o 5-44
ZOOTN OPHIONS ...ttt e 5-46

Handling Completed Trays........cccooiiiiiiiininiiiiiiiicii s 5-47
Tray Validation ... 5-47
Production ESHIMALES ........c.covoiiiciciei e 5-48
Printing MOAES ........ccueiiiiiiccicieee et 5-48
E-mailing Objet Digital Files.........ccccccoviiiiiiiiiiiiii s 5-49
Printing the Tray File ... 5-50

vi DRAFT

16 June 2013



User Guide

Applying Additional Objet Studio Features..........cccccoviiviniiiinininiiiiicicccce 5-54
Dividing ODJectS......ovieiecieieiei s 5-54
Choosing the Support Strength ... 5-55
“Hollow” — Filling Models with Support Material...........cccccocoeviiniiiiiiiccce 5-56
Displaying the Cross Section of ObJECtS ..........ceeviiiiiiiiciniiiiicc s 5-57
Saving the Screen Display as an Image File..........cccoooiiiiiiiiiiiccc e 5-58
Exporting and Importing Objet Build Trays.........cccooviiiiiniiiiiiiiniiiicnccnns 5-59

Customizing Objet StUAI0 ... 5-60
Creating a Quick Access TOOIDAT ... s 5-60
Hiding the RIDDOIN .......ccviiiiiiiiiiii s 5-61
DiSPIAY COIOTS ..ottt s 5-62
Keyboard ShOTtCULS .......c.coiiiiiiiiiiiiii s 5-63
Setting User Preferences ... 5-64

Professional Mode FEatUIes ..........cccviiiiiiniiiniiiiii e 5-65
Default SELHNGS ....cvvieciiciiiic s 5-66
Open GL Driver CONfigUuration ... sssns 5-67

Getting Additional Objet Studio AssiStance..........cccoceiiiiiiininiiiciies 5-69

Objet Studio Version, Material Module and Licensed Features............cccocovniniiiiniiinninnnee. 5-69

Monitoring and Managing Print JObS ... 5-72
JOD MANAGET SCIEEMN ..ottt st 5-72
Setting the Printer CONNECHON .........coviiiirieieiecce s 5-74
Off-lINE MOTE ...t s 5-75
Setting the Remote Printer Connection (Client Mode)............cccoccueurnnniiccenrnicccenenenes 5-76
Job Manager COMMANAS .........ccoviiiiiiiiiiiiii s 5-76
Configuring USer ALTLS.........coiuiiiiiiiiiiiiiiiiii s 5-79
Printing the TTaY .....ccoovviiiiiiiiic s 5-80
Additional Server FEatures............oooviiiiiiiiniiiiiii s 5-80

6 Operating & Maintaining the Objet1000 - Connex 2 3D Printer

Starting the Objet1000 Printer ... 6-2
Loading Model and Support Cartridges ... 64
Producing Models.........ccciiiiiiiiiii e s 6-5
Printer Interface Color KeY ........ccccuviiiiiiiiniiiniiiiciiic s s 6-7
Printing INAICALOTS ....c.oviviiiiictcc e 68
Resuming Production After Printing has Stopped ... 6-9
Changing the Model Material..........cccccviiiiiiiiiniiiiniiiiiii e 6-11
Advanced SEttNGS ........ccoveviiriiiiiiic s 6-14
Keeping the Printer in Idle Mode ..o 6-16
Shutting Down the Printer ... s 6-17
Maintaining the Printer..........ccoi i s 6-19
Routine Maintenance Schedule..............coooiiiiiiiiic s 6-19
Cleaning the Print Heads........ccoooiiiiiiiiiiiiiici s 6-20
Pattern TOSE .....ovovivieci s 6-23
Improving Print QUAlItY ... 624
Cleaning and Replacing the WIPer ..o 624
Cleaning the Roller Waste Collector and Inspecting the Roller Scraper ...........ccccoovvvururirnnnen 6-27
Replacing the ROIIer SCraper ... 629
Aligning the Print Heads ... 6-32
Replacing Print Heads. ..........ooviiriiiieci s 6-36
Testing and Calibrating the UV Lamps........ccccooiiininininiiiccccsc s 6-36
Calibrating the Load CellS.........ccooviiiiiiniiiiicic s 6—40
Replacing the UV LampPs ........cccriieiiiiiieieete et 6-42
BUIIE-AN T@SES ...t s 6—47
Replacing the Waste CONtaineT ............ooviruriiieieiiiiicce s 6-53
.Cleaning the Exterior Panels ...........ccccooiiiiiiiiiiiin s 6-53
DOC-06800 Rev. A DRAFT vii

16 June 2013



Objet1000 - Connex 2 User Guide

viii DRAFT
16 June 2013



DOC-06800 Rev. A

About This Guide

Using This Guide

For More INfOrmation .........oooveieeevieiieieieeeee ettt saeeeene
Terms Used in This GUIAEe.......coovuvviiiveiiiiiiiieeeeeeceeeee e

DRAFT
16 June 2013



About This Guide

Using This Guide

This user guide provides instructions for installing, operating and
maintaining Objet 3D printing systems. It explains how to use features, and
provides practical examples to guide you as you use the system.

The text and figures in this guide are based on the 3-D printer, printer
software version 100.2.0 and Objet Studio software version 9.2.

This guide assumes that:

® all the hardware, software, and network components of your Objet
system are installed, configured, and operating correctly.

® the operator has a working knowledge of the Windows® PC platform.

For More Information

Visit http://www.stratasys.com/ for more details about Objet printer
technology, products and consumables, and for service and support
contacts.

For other documents that relate to Objet1000 - Connex 2 3-D printing
systems, and for this document in other languages, contact your regional
Stratasys Customer Support office.

If you have any questions about the information presented in this
document, or if you have any comments or suggestions for future editions,
please send a message to c-support@stratasys.com.

DRAFT DOC-06800 Rev. A
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Terms Used in This Guide

build tray

cleaning fluid

client/user workstation

Objet™ printer

Printer computer

Printer interface

Printer software

Digital Material™

Digital Material Mode

host/server workstation

Job Manager™

mixed part

mixed tray

Model material

Objet Studio™

In Objet Studio: The surface displayed on the screen that
represents the actual build tray in the printer.

In the printer: The surface upon which models are produced.

Cleanser for flushing material feed tubes and the printing
block, used to completely remove Model and Support
material from the system before loading another type of
material in the printer and before long-term shutdown. The
cleaning fluid is supplied in material cartridges.

The workstation on which Objet software is installed, used
for preparing build trays for production on Objet printers.
(There is no limit to the number of client workstations in the
local network.)

The Objet 3D printer referred to in this guide.

The computer inside the Objet printer that operates it. (This is
sometimes referred to as the “embedded” computer.)

The GUI (graphical user interface) used for controlling the
Objet printer.

Software running on the computer inside the Objet printer,
that controls all printer operations.

Combinations of model materials fabricated in the printer
from the two basic model materials installed.

The printer mode used to print a job using two different
model materials. (This mode can also be used to eliminate the
need for performing the Material Replacement procedure
when printing with a single model material.)

The workstation that interfaces directly with the Objet printer
and is typically positioned next to it.

The part of Objet Studio software that manages production
jobs before they are sent to the Objet printer.

Models whose parts are printed using more than one model
material.

A build tray containing objects, each of which is designed to
be printed using a different model material.

Material used for building models.

The software with which users prepare jobs for producing
models.

OBJDF (Objet Digital Format) The extension of a file that contains information about the

DOC-06800 Rev. A

geometry of an object and the materials required to print it.
objdf files are created in Objet Studio.
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OBJTEF (Objet Tray Format)  The extension of a file that contains all of the information
needed for a model-printing job on Objet 3D printers. An objtf
file is used to send a print job to an Objet 3D printer.

OBJZF (Objet Z Format) The extension of a compressed “wrapper” file containing all
of the files used in an Objet Studio build tray. Using objzffiles,
a printing job can be saved as a single file, for convenient
storage and transfer.

PolyJet Matrix™ The technology of printing models by jetting multiple
materials simultaneously from the print heads. This
technology enables Objet1000 - Connex 2 printers to print in
Digital Material mode.

resin The base substance from which photopolymer printing
materials are made for use in Objet printers. In Objet Studio
and printer-application screens, “resin” refers to cartridges of
model and support materials.

SLC A file type used with Objet software. (These files are bitmaps
of individual slices of the object. For more information, see
page 3-4.)
STL A file type used with Objet software. (For more information,
see page 3-4.)
Support material Material used for supporting the structure of models during
production.
1-4 DRAFT DOC-06800 Rev. A
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Safety Features

Objet 3D printers are designed to comply with CE and FCC standards.
They are equipped with the following safety features:

Interlock Switch ~ The power supplied to the UV lamp and the
motion motors is turned off when the doors are
opened.

WARNING: Do not defeat (override) the
& interlock switch. Doing so could result in
serious personal injury. If the interlock switch
does not function correctly, do not use the
printer, and contact your service provider.

Safety Lock The doors are locked while the printer is
working. The lock is released when the printer
reverts to pause or stop mode.

safety lock. Doing so could result in serious
personal injury.

If the safety lock does not function correctly, do
not use the printer, and contact your service
provider.

: WARNING: Do not defeat (override) the

UV Screening The transparent section of the doors blocks
harmful UV radiation, allowing the operator to
view the model as it is being made.

Circuit Breaker The power to the printer is turned off in case of
electrical overcurrent.

Note: The circuit breaker is only accessible to
service personnel.

Grounded Chassis The chassis of the printer is grounded, to
prevent electrical shock.

Note: The power outlet must be properly
grounded, in accordance with the local
electric code, to provide this protection.

Emergency Stop Emergency stop switches are located on the
front and back of the printer.

Important: Pushing the emergency stop
switch disconnects power to motors only.
It does not disconnect the power supply to
the printer; printer circuits remain on.

Figure 2-1: Objet1000—front view

Figure 2-2: Emergency Stop Switch—Push to stop motors, turn to release

2-2 DRAFT DOC-06800 Rev. A
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If the Objet 3D printing system is not used as specified in this guide, the
safety features may not provide adequate protection.

%R

Symbols and Warning Labels

This following table lists the warning labels located on or in Objet printers.

Warning Meaning Location Comments

Symbol
Hazard On the name plate | Read the instructions
(general) on the back of the | in this document

printer.

before operating the
printer.

Hot surface

On the print-head
block.

Risk of burns. Do not
touch this surface
after printing.

16 June 2013

High voltage | Near . Risk of electric shock.
Near the power-
supply enclosures.
Ultraviolet Risk of injury from
radiation ultraviolet radiation.
Moving parts Risk of injury from
moving parts.
DOC-06800 Rev. A DRAFT 2-3




Safety

Safety Guidelines

Printer
Installation

Printer
Operation

UV Radiation

Prir_1ter
Maintenance

%R

The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the Objet system. If the system is not operated as specified,
the user's safety may be compromised!

» Installation and removal of the printer should only be done by qualified
service personnel.

» Connect the printer to the electric outlet using a power cord that is
safety-certified.

Y

The electric outlet should be easily accessible, near the printer.

» Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose
the operator to serious danger from electric shock.

» Leave a minimum of centimeters between ventilation openings and
walls or other objects.

» The printer should only be operated by persons trained by a Stratasys
customer-support representative.

» All personnel operating or maintaining the printer should know the
location of first aid and emergency equipment and how to use it. Never
block access to this equipment!

Y

Keep fingers and other body parts clear of the printer cover when
closing it.

Never attempt to open the main cover of the printer while it is working!
Never override the interlock safety switch!

If the interlock safety switch ever fails, do not use the printer.

V V V V

Several parts of the printer remain extremely hot even after it has
stopped operating. Avoid touching the UV lamps and the print block.

The UV lamps used in the printer emit dangerous radiation.

» If the UV lamps remain on when the printer cover is open, do not stare
directly at the UV light. Shut down the printer and call your Stratasys
service provider.

» Service operations should be performed only by qualified personnel
who have been instructed in relevant safety precautions.

» Notify co-workers and those who have access to the Objet system
before beginning non-routine and hazardous work.

Report any potential dangers and safety-related accidents to your safety
officer or to other appropriate authorities.

DRAFT DOC-06800 Rev. A
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Model and
Support
Materials

DOC-06800 Rev. A

Model and support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all
model and support materials used by the Objet system are handled in
sealed cartridges. Normally, operators of the printer should never be
directly exposed to hazardous materials. In the unlikely event of a leak or
spill, follow the instructions that are included with the printing-material
cartridge used.

» Store cartridges of model and support materials indoors, in a dry area
with adequate ventilation, between 16-27 degrees Celsius (60-81
degrees Fahrenheit). Never expose them to flames, heat, sparks, or
direct sunlight.

» Keep model and support materials away from areas where food and
drink are stored, prepared and consumed.

» Uncured printing material is considered a hazardous substance,
requiring certain precautions when directly handling it. To prevent skin
irritation, wear neoprene or nitrile gloves. If there is any chance that
model and support materials might splash into the eyes, wear safety
goggles. Prolonged direct contact with printing materials can cause an
allergic reaction.

» When handling UV-cured models that may not be completely cured on
the surface, common latex gloves are adequate.

» To prevent respiratory irritation, ventilate areas where model and
support materials are used. The ventilation system should totally
replace the air at least 20 times per hour.

» Clean up model-material and support-material spills with disposable
towels or other absorbent, non-reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl
alcohol (IPA), followed by soap and water. Dispose of the absorbent
material in accordance with local regulations.

» Do not wash contaminated clothing at home; clothing should be
professionally laundered.

» Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing
material may re-expose the user when these items are worn.

DRAFT 2-5
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First Aid for Working with Printing Materials

%

Contact with
Skin

Contact with
Eyes

Ingestion

Inhalation

2-6

In general, try to avoid direct contact with uncured printing material. If
skin or eyes come into contact with it, wash the area immediately and
thoroughly with water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing
materials contains important safety information. Keep this in an accessible
place where these materials are used and stored.

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.

» Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.

» Do not use solvents to clean skin.

» If large areas of skin have been exposed, or if prolonged contact results
in blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.

» Avoid the accidental transfer of printing material from the hands to
other areas of the body, especially to the eyes.

» If protective cream was used, do not reapply it until the skin has been
completely cleansed.

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.

» Avoid sunlight, fluorescent light, and other sources of ultraviolet
radiation.

The wearing of contact lenses when handling liquid printing materials is
not recommended. If the liquid splashes into the eyes when contact lenses
are worn, immediately remove the lenses and flush the eyes with water.

» Clean and disinfect the contaminated lenses.
» Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.

Vapors from printing materials can be irritating to the respiratory system.
If respiratory irritation occurs, expose the victim to fresh air immediately.

» If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

Seek medical attention immediately.
Keep the patient warm but not hot.

Never feed anything by mouth to an unconscious person.

V V V V

Oxygen should be administered by authorized personnel only.
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Waste Disposal

Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste.

DOC-06800 Rev. A
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>

>
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When removing the waste container from the Objet printer, wear
neoprene or nitrile gloves.

To prevent liquid waste from splashing into the eyes, wear safety
goggles.

Liquid waste from the Objet printer is classified as hazardous industrial
waste. Therefore, printing-material waste must be packaged and
disposed of in a manner that prevents human contact with it and
contamination of water sources.

Empty model-material and support-material cartridges contain residue
of their contents. Some leakage of this residue may occur through the
broken cartridge seal. Therefore, handle and store empty cartridges
with care.

Do not attempt to reuse empty cartridges, and do not puncture them.

Dispose of used cartridges and waste containers in accordance with
local regulations.

Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.
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Welcome to Connex

The advanced capabilities of the Objet 3-D printing system are made
possible by PolyJet Matrix™ technology, specially developed by Objet for
printing models simultaneously with different model materials. For the
first time, you can achieve the following results when printing 3-D models:

* You can prepare models for printing with designated model materials
and then print them —using two basic model materials loaded in the
printer, or combinations of these materials (digital materials).

* DParts of the same model can be made—simultaneously —from different
materials.

* Models made from digital materials can have unique physical
properties, depending on the materials used.

* You can print objects that have a “coating” made from a different
material than the main part of the object.

In addition, because Objet printers can be loaded with two different
materials, and can print simultaneously with combinations of them, you
can streamline and economize the process of producing models:

* You can print models made from different (single) materials on the
same build tray (“mixed tray”), in the same print job. This eliminates
the time-consuming need and expense of loading another material,
flushing the system, and sending a separate job to be printed.

* You can quickly alternate printing jobs with either of the model
materials loaded —or with material combinations —again, without the
need and expense of replacing materials.

The Objet system also enables you to split models into component parts
(“shells”) so you can isolate, manipulate and print parts of a model.
However, you have ultimate control when separating models into shells by
preparing st files with your CAD software. Then, with Objet software, you
can assign model materials and other characteristics to the shells.

Figure 3-1: The 3D Printer
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Work Configurations
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The Objet 3D printing system can be set up as a single-station system or as
a multi-station system. When connected to a local computer network, the
system can serve multiple users. In such configurations, each user
workstation (client) prepares files with Objet Studio software for
production. A server (host), typically next to the 3D printer, acts as a job
manager that sends production jobs to the printer for production.

Figure 3-2 shows the printer set up in a multi-client configuration.

Client
workstations

Printer

Figure 3-2: Multi-client network configuration

When installing the Objet software, you choose whether to install it as a
client station or as a master station (server or standalone station).

The Objet software arranges the jobs it receives according to their priorities,
model-material type, and other factors. In multi-workstation
configurations, the operator of the server —typically the production
administrator —has total control over the jobs sent to the 3D printer, and
can prioritize and delete jobs, review job history and reprint a job, and so
on.
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Source Files

STL Files

SLC Files

Objet 3D printing systems produce three-dimensional models designed
with most 3D CAD tools and with other job-specific 3D applications. Objet
systems accept:

* STL Files
e SLC Files

Objet systems feature the capability of producing both types of model files
simultaneously.

STL is short for Standard Triangulation Language. This language views any
object as a collection of surfaces, and describes each surface of the object as
a collection of triangles.

For example, a square can be described as two triangles; a cube (six
squares) as 12 triangles. Curved surfaces need more triangles to describe
them. The higher the tolerance (for smooth surfaces), the more triangles are
needed. The resultis that high-quality object descriptions mean very heavy
files.

Most CAD software can export STL files. The Objet system utilizes these
tiles for building models (rapid prototyping), and also for directly making
molds for mass-producing items.

STL files can be ASCII (text) files or binary files. The content of the ASCII
tile begins with “solid” and ends with “end-solid” (both lower case).
Between these keywords is a list of the triangles that describes the faces of
the solid model. Each triangle defines a single normal vector directed away
from the solid’s surface, followed by its X-Y-Z coordinates. These are
expressed as Cartesian coordinates and are floating-point values. The
coordinates of all triangles should be positive and should fall within the
volume of the model.

SLC is short for Stereo-Lithography Contour. SLC files describe two-
dimensional contours of the three-dimensional models. These contour lines
are polylines.

SLC files are ASCII (text) files that save models as a series of slices. This
means that models based on SLC files cannot be orientated; only their scale
(size) and position on the build tray can be controlled. For this reason, the
model’s orientation must be suitable for production before it is saved as an
SLC file. Because of the nature of SLC files, the appearance of models in
Objet Studio may be different than the solid-object images displayed from
STL files.
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Connex Workflows

With Objet Connex 3-D printing systems, you have great flexibility in
preparing model files and printing them. Below are the major workflows
that have been made possible by Poly]Jet Matrix technology on Connex
systems. You can find detailed instructions for implementing the listed
tasks in chapter 5 (“Using Objet Studio”).

Stage

Workflow A

Workflow B

Workflow C

CAD program

e v ¥ L ——

[——

Design a 3-D object.

Save as a single stl
file.

Open (Insert) the stl
file.

Separate the object
into its components
(“shells”).

Assign materials to
the components.

Design a 3-D object.

Save the object as an
assembly of st! files.

Open (Insert) the stl
files as an assembly.
Assign materials to
the assembly’s
components.

* Save the object as an objdf file (optional).

* Open (Import) an
objdf file. (objdf files
contain model-
material
information.)

* Save the build tray. / Send the build to the printer.

Models are produced in the printer.

* Remove the support material from the models.

Finished model.

DOC-06800 Rev. A
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Printing Materials

Storage

Shelf Life

Exposure to

Light

Safety

Considerations
3-6

Objet printers produce models by jetting thin layers of printing materials
on the build tray, until the complete model is formed. Two types of material
are used in this process:

* Model material —which makes up the finished model

* Support material —which fills gaps and spaces in the model during
printing, and is removed after printing

Materials used for printing models with Objet printers are made of resins,
which are composed of reactive monomers and oligomers. Although
printing materials are supplied in sealed, UV-proof cartridges, care must be
taken when storing and handling them. Follow these guidelines to protect
operators and the environment, and to ensure optimum results.

* To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances
(such as polystyrene or polyvinyl chloride) are not suitable for storing
Objet printing materials.

*  When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

* Store material cartridges indoors, in a dry area with adequate
ventilation, between 16-27 degrees Celsius (60-81 degrees Fahrenheit).
If exposed to heat or flames, cartridges may burst or ignite.

* Signs of premature polymerization in material cartridges may include
bulging, leaking, the emission of heat, and unusual odor. Exposure to
heat can cause resin to gel in the cartridge.

* Make sure that material cartridges are stored in accordance with all
local regulations and other applicable requirements.

Materials used for producing models have a limited shelf life. The expiry
date on the label is valid when properly stored in an undamaged,
unopened cartridge. Always rotate your stock, so that the cartridge with
the earliest date is used first.

If printing materials are not in their sealed cartridges, make sure to shield
them from sunlight and other sources of UV radiation, such as fluorescent
and mercury-vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.

Before being cured, resins are hazardous materials. To prevent possible
health hazards, follow these precautions regarding printing materials:
* Do not expose to flames, heat or sparks.

* Prevent contact with skin and eyes.

* Ventilate areas where they are handled.

* Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

You can find more safety information about resins in “Safety Guidelines” on

page 2-4, and “First Aid for Working with Printing Materials” on page 2-6.

DRAFT DOC-06800 Rev. A
16 June 2013



Objet1000 - Connex 2 User Guide

Disposal

Dispose of cartridges of Objet model and support material in accordance
with all applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling.

Work Environment

DOC-06800 Rev. A

Extreme heat and humidity conditions can adversely affect the operation of
the Objet 3D printer. Therefore, it is recommended that you use ventilation
or air-conditioning systems, if necessary, to keep the work area within the
following ranges:

* 18°-25° C (64°-77° F)
* 30%-70% relative humidity
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Preparing Files for Use with Objet 3D Printing Systems

Converting
CAD Files to
STL Format

A

Converting
Files to SLC
Format

Before using files with Objet 3D printing systems, you must convert them
in your CAD program to either st! files or sic files. (For an explanation of
these file formats, see “Source Files” on page 3-4.)

After converting the model files, it is recommended that you check them for
defects in an STL-repair application (such as Magics™, by Materialise®)
before opening them in Objet Studio and producing the model.

This procedure may vary slightly, depending on the CAD software used,
but the following instructions generally apply.

To convert a file to STL format (in a CAD program):

1. From the File menu, select Save As.

2. In the Save As dialog box, open the Save As Type pull-down menu and
select *.STL.

3. Click Options and set the following parameters:

* Total Quality —approximately 0.01 mm (deviation tolerance /
linear-dimension tolerance)

* Detail Quality —approximately 5° (angle tolerance)

Note: Lowering these values produces more accurate models, but
results in larger files and longer loading and processing times. For this
reason, it is generally not recommended that you use lower values.

4. In the file format option, choose binary or ASCII. (Both binary and
ASCII formats can be used in Objet Studio. However, binary files are
smaller, so this option is recommended.)

5. Click OK or Save.
For more information, search for “CAD to STL” on objet.com.

When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that models are properly orientated before
being saved as SLC files. Considerations for suitable model orientation are
explained in “Model Orientation” on page 5-29.
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Objet Studio Software

Objet Studio software for the Objet 3D printing system consists of two main
screens:

* Tray Settings / Model Settings
* Job Manager

Tray Settings / Model Settings

In the Tray Settings and Model Settings screens, you prepare source files for
production in Objet 3-D printers. Objet Studio offers you a wide variety of
file-preparation options, but always consists of the following basic

procedure:

1. Inserting one or more objects on the build tray

2. Positioning the object(s) on the tray

3. Configuring object and tray parameters

4. Saving the tray configuration as an objtf (Objet Tray Format) file

5. Sending the objtf file to the Objet 3D printer for production

Using Objet Studio to perform these tasks is described in detail in chapter 5,
“Using Objet Studio.”

Job Manager

The Job Manager screen is different for client workstations and for the
computer connected directly to the Objet 3D printer.

* In Objet Studio installed on the directly-connected computer (server),
the Job Manager screen displays the queue and status for all jobs sent to
the 3D printer by the server itself and by all client computers on the
network. All jobs displayed can be edited and manipulated.

* In Objet Studio installed on client computers, the Job Manager screen
displays the queue and status only for jobs sent to a 3D printer server
from that computer. Only these jobs can be edited and manipulated
from the client computer.

3D printers, but only to one at a time. The Job Manager screen displays the

% Client computers can be connected, via the local network, to different Objet
status of the 3D printer to which the client is currently connected.
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Installing Objet Software

How to Install Software for the Objet 3D Printing System
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How to Install Software for the Objet 3D Printing System

The Objet Studio setup wizard guides you when installing the Objet
software. During installation, you must choose to install either the server

4-2

(“host”) application or the client application.

To install Objet software:
Insert the Objet Studio CD into the disk drive.

Right-click the Start button and select Explore (or use any other method
for displaying files on the computer).

1.
2.

Open the CD-drive folder and select Setup.

If you are installing an Objet Studio upgrade, make sure that your
printer is compatible with it by checking the list displayed.

Objet Studio Setup

i 1 Please noe. ..

= This version of Objet Stucio is *not™ compatible witt the “ollowing

verainng of the printer enfhware:

- Connex500, 57.0 (3nd kelaw]
- Conmex350, 37.0 (snd kelow)
-Eden50CV, 5C.2 {and below)
- Eden35CY, 3€.0 {and below)
-Eden2&CV, 27.0 (and below)
- Eden35C (all versions)

- Eden33C (all vercione)

- Eden2aC {all versions)

- Cden25C {all versions)

- Alaris30 {all versiors)

If the printer software is incomoatible, printing will not be possble
aller this Dbjel Studiv installalion,
For more informatior, contact vour Objet servize provide.

To install Objet Studio, dick OK.

OK. I Cancel |

Figure 4-3: Objet Studio compatibility check

To install Objet Studio, you must agree to the license agreement. After
reading its terms, click Yes to continue, or No to close the wizard.

If you click Yes, the following screen should appear.

% Objct Studio 9

Welcome to the Objet Studio 9 Setup Wizard

The inztaller will guide pou through the steps required bo install Objet Studio £ om your
ftulysl (Rl

’ Cance | ’ < Eack

WARMING. Thiks Ccomputer progigim is protecled oy cusgighl lav and inlemclivnal leales.
Unauthorized duplication o distrbution of this program. or any portion of it, may result in sevele civl
or crminal pendties, and will be srosezutec to the masimum extent possible under the law.

Mew: »

Figure 4-1:0bjet Studio installation wizard—Welcome screen

6. Click Next to begin installation.
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7. In the Select Features screen, select the required installation option.
Select Objet Studio for a server computer...

® if you are installing Objet Studio on a server (“host”) computer —
the computer directly connected to an Objet printer.

® if you are installing Objet Studio on a standalone (off-line)
computer.

Select Objet Studio for client workstations if you are installing Objet
Studio on a “client” workstation—a remote computer that prepares
print jobs and then sends them to a server computer.

i# Objet Studio

Select Features

Selezt the prefered Objet Studialnstalatior type for your computer

(%) Obijct Studio for a sorver compuicr.

() Dbjet Studio for cliert workstations.

[ Cance | [ < Eack ] [ Mex: >

Figure 4-2: Objet Studio configuration selection

8. In the Select Installation Folder screen, verify the destination folder and
click Next.

%( It is recommended that you do not change the default destination folder.

Click Disk Space to check the space in the destination folder.

1% Objet Studio 9

Select Installation Folder

The inztaller willinstal Objet Studio to the following folder.

To install i1 thiz folde, click "Medt”. Tainstall to a different folder, enter it belaw or click "Browse’.

Folder:
C:\Pragram =ileshJIbjats tudiak Erowmze..
Jisk Space...
Iistall Chiet Studia far poursel, or for amyonns who uses this computar.
Cance . Eack Mew: »

Figure 4-3: Objet Studio installation-folder selection

9. In the Confirm Installation screen, click Next to begin installation.
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Installation begins and a progress bar appears, showing the progress of
the installation process.

15 Ohjet Studin 9

Installing Objet Studio

Objet Studio 9 iz being installed.

Plzase aai...

Cance

Figure 4-4: Installation progress bar

When the Objet program installation is complete, the final InstallShield
Wizard screen appears.

i# Dbjet Studio 9

Installation Complete

Objet Studio 3 Fas been sLocessfully hstallzd,

Click "Cloze"" bo exit.

Close

Figure 4-5: Final installation screen

10. Restart the computer to complete the software installation.

Note: Make sure to remove the CD from the disk drive before restarting the
computer.

The installation process ends when the appropriate icon(s) appear on the
computer desktop:
® Objet Studio

® Stop Job Manager (for servers and standalone stations)
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How to Uninstall Objet Studio
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If there is ever a need to uninstall the Objet Studio software, do not attempt
to do so from the Windows Control Panel. (This does not completely
remove all software components.) Instead —

» From the Start menu, select All Programs > Objet Studio > Uninstall Objet
Studio.
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Launching Objet Studio —

Windows® 7
Security
Warning
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After you install Objet Studio, a launch icon [sse sece] appears on the
Windows desktop. Open the application by double-clicking this icon, or by
selecting Objet Studio from the Start menu.

Depending on the User Account Control settings in Windows® 7, you may
see the following warning when opening Objet Studio.

re= -
5 User Account Control w

| \@ Do you want to allow the following program from an
* unknown publisher to make changes to this computer?

Program name:  ObStudic.exe

Subslisher Unibosowm
File crigir: Harc drive onthis computer
(») Show details Y | [ Mo

Chznge when these notifications appear

Figure 5-1: Security Warning

If you click Yes, Objet Studio opens. However, this warning message will
appear each time you open the program, unless you change the User
Account Control settings.

To prevent the warning message from appearing again:

1. Click the link at the bottom of the security warning dialog box (Change
when these notifications appear).

2. Inthe User Account Control Settings screen, move the slider to “Never
notify.”

= = "
Byl User Succunl Uonliol Sellmngs e
Chisessie whewr Te b neslilied acheon shiareg s e yeor sangular
Lserazcount Control helps provens potontia v hornful crograms from moking changes bo your compuber,
Tel! e mare ahout User Arcount Control settings
Always nobry
= = Motlfy me only when programs try te make changos ta
my eamprtes (dn nat dim my desddap)
& oL ol el Lnake cherges Lo Windooe
=== sektings
==
B Mol erommmeded Chouee tis unly 17 Lakes 3 ony
time be 4 tre deskiop or your comoutar,
Hewor notify
| ek Cancel

Figure 5-2: Changing the User Account Control settings
3. Click OK.
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Objet Studio
Interface

5-4

In the following dialog box, click Yes.

changes to this computer?

il Program name:  UserfccountControlSettings
\\d!f Verified publisher: Microsoft Windows

(3 Show details Yo | No

Change when these notifications appear

-
Hl User Account Control W

Do you wanl l allow the [ollowirg progiam o make:

Figure 5-3: Confirming the change in the User Account Control settings

When Objet Studio opens, the Tray Settings screen appears, showing an
empty build tray.

Objet Studio 7/
Commands /
Quick Access

Model Tree

menu” 7 em

toolbar

pane

"

Figure 5-4: Objet Studio opening screen

The Objet Studio interface consists of two main screens:

- Help
\ Standard

toolbar

Active
ribbon

Job
Manager
tab

Tray Settings—for arranging models and preparing them for printing.

This screen is described below.

Job Manager—for monitoring and managing print jobs.

This screen is described in “Monitoring and Managing Print Jobs” on

page 72.

Each screen is controlled by menus and icons on its own ribbon. An
additional ribbon, Model Settings, displays controls for configuring and
manipulating selected models.

Objet Studio anticipates your workflow by displaying and enabling the
options relevant to your current task. For example, when you first open
Objet Studio, the Model Settings ribbon is disabled until you place a model
on the build tray. Similarly, menu options available from the Standard
Toolbar menus are enabled or disabled to match the current workflow.

DRAFT
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The ribbon, colors used, and several other interface features can be

customized. How to change the appearance of the interface is explained in
“Customizing Objet Studio” on page 60.

Instructions for using the commands for preparing models for production
and sending jobs to the printer, appear later in this chapter.

Tiay Setngs | Job Manager

Ldt - ¥iew - Object ~Tools - Sty'e ~ (gl -
.b: 1@] g Mew .'_:._ L...I Q ﬁﬂ m E WeroBlzck - ~ Single Material
Irsert | Pis t LA ‘; Open | ypndo feds Single Zoam lsometri By legend | MercWhite 4 Wuliple Matenals
B Element = % Save s = Tray ~ - Matarial -
Model  Bullc Frocesy || Selection File Edit View Colors Coarenty lcadec: VeroBiack, VeraWnits
Figure 5-5: Tray Settings ribbon
J/‘g\\xl %% 2 & 5 Applictions_CuttingScsiors Objct Studic: Objctl000 Connes2 o] it
Tray Settings Mndel Settings lnh Manzger Edit ~ view T Ubject ~ focls * style v gl -
. X - o % 7B 14 a3 mm ) )
»% % B8 a @ & iy @e x (0
fy 0 Select Mave Transforn Lock || Single Zoom  Isometric ||V [3438 Millimeter | |Matte|Glossy Advanced | Multiple ||Colors
¥ Element - View = Tray~ = 7 880 il Materals - -
Edit Selecticn Mnnipu atc
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Ribbon The following table lists the Tray Settings and Model Settings ribbon
Commands command groups, and shows when they are enabled, and where they
appear.
Group Purpose When Tray Model
enabled Settings Settings
Ribbon  Ribbon
Setting display | Always.
ggg colors. d d
By Leqend
Material =
Colors
@] Q Selecting Models are on
; ti d | the build tray.
R R I AR 4
View ~ Tray -
View
%‘g Choose to select | Models are on
Select a plane, the build tray.
_Element - elements, or d i
ﬁ{é}_’”ction element groups
%%' (assemblies).
& Change the Models are on
tsonetric perspective of | the build tray. d d
i the active pane.
e
b))
VewBlak * Single Malerial Assigning model ° Build tray
FunlCured 21 - o Multinle Materials material(s)' iS empty d
Currently luadeds VeroBlack, VeroWhile ¢ MOdels are
not
selected.
Nl Undoing or After an
e redoing actions. | action or
R obf'ect d J
. selection.
Edit
SRor = Opening and Models are
‘Jw;.;f' @’.« E saving files. not selected. d
Mew Open Save
File
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Group Purpose When Tray Model
enabled Settings Settings
Ribbon  Ribbon
C‘EQ Placing model | Always.
files on the build d
Insert tray.
Model
r R n 'é' Pre-build/build | Models are on
A o T .
‘#ﬁ @ < commands. the build tray. d
Flacement validate Estimate Build
i ==C [ unforr scale| Setting model | A model is
el dimensions. selected. i
2 [1.01
Dimersions {mm}
Lo (Lt %3 ¥ 4] Cutting, A model is
™ Copy = copying, pasting | selected.
k| o Delete Undo  Redo and deﬁeting J
£ models.
Edit
® @, &4 Moving, rotating | A model is
- - : f L’u% and resizing selected. J
Mawve Transform  Loc models.
[Manipulate
DM_8310_Grey25 - @l * Assigninga | A modelis
;ﬂ c material toa | selected. d
b eparate to Shells
model or
Multiple Materials shell.
* Separating a
model into
shells.
‘ @D Assigningmodel | A model is
. fini lected.
Matte ! Glossy ddwanced ml? an s€
setting support
_ strength/
Options “hollow.”
i Setting amodel’s | A model is
. unit of measure | selected. i
- (millimeters or
_ inches).
Lnits

To quickly identify an icon, move the cursor over it to display a tooltip. The
“Undo” and “Redo” tooltips change to reflect your last Objet Studio action.

After activating some of the ribbon commands (by clicking them), they remain
active until you click another button or until you press the Escape key.

A
A
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Objet Studio Clicking the @ icon in the upper-left corner opens the Objet Studio

Commands Commands menu. This menu displays basic application commands and
Menu options.
Q fole S8
ré;,- M Recent trays
é i ‘_|_F.'.|iﬂ un
é’ N P AR

I PongrEm Fles). L Trassh
[
i cous
‘é Savzde. £ P rupnFiest ATiagel
Ié. Cav=[knap., LoD

:}? LoportFacked Jul, .

‘;} Explilbrainilgeliz:

_,le Fuld Ereperti=s.. .
;ié User Frefarances

9 Erinm Frpue i

Treslarl

Figure 5-7: Objet Studio Commands menu

The Options button opens a dialog box for customizing Objet Studio.

Appearance | Grid | ianipulate | Display | $=tings |
Automatic Placenent

Quick Automatic Flacenent after adding new object

Freserve 1 mm  ditance behween obects

Automatic Lay On [Gravity]

) Newer

@) Aways

) When Jnder the tap
Large Files

(@) Load Ful

> Load Fartial (reduzed)

Load Search Order
) Local

Ok ] [ Cancel ]

Figure 5-8: Options dialog box

Model Tree The Model Tree pane lists the objects placed on the build tray in a parent-

Pane child hierarchy. By default, the pane “floats” — that is, you can move it to
another position on the screen and resize it. Alternatively, you can fix its
position at the left of the application window, and even hide it.
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Preparing Models for Production

Model preparation involves the following basic steps:

1. Place objects or assemblies on the build tray.

2. If necessary, manipulate the object’s orientation and position.
3. Select the materials and model finish.

Just as Objet printers can produce different models on the build tray using
different materials, you can produce components of a model with different
materials. To do this, each part of the model must be a separate st file. If the
model’s component parts were not saved in the CAD software as separate
stl files, you can use Objet Studio to separate the model into component
parts. (This is described in “Splitting Objects into Components” on page 18
and in “Dividing Objects” on page 54.)

OBJDF Files: An objdf file describes both the geometry of a single object and the

Overview materials, and finish required to print it. The objdf file can represent an
object that is a single st/ file, or an object assembled from component st!
files.

Objet Studio enables you to split an st! file representing a complex object
into an assembly of component st/ files, and save the assembly as an objdf
tile. Each part (st file) described by the objdf file can have its own model-
material characteristic, so that the Objet printer produces the component
parts from specific materials.

Another use for objdf files is for saving a group of separate objects on the
build tray as one unit, together with their relative positions and materials.
This is especially useful for producing models in the future with the same
materials. In fact, when you save objdf files, you specify materials for
printing models without regard to the material cartridges loaded in the
printer. The same object can later be placed on build trays for printing. Each
time you send a build tray to the printer, you decide whether to allow
printing with substitute materials or only with the materials specified.

The Connex version of Objet Studio enables you to display, manipulate and
print component parts of a model assembly that was saved as an objdf file,
since each component is a separate st! file. This can be useful for printing
only specific parts of a model.

Further explanations of files, and their features, appear throughout this
chapter.

Model Files To produce models, you open one or more model files in Objet Studio and
position objects on the build tray. You can place objects on the build tray in
several ways:

* by inserting individual st or slc files (or an assembly of stl files).
* by inserting an objdf file (an assembly).
* by pasting objects that you copied to the Windows clipboard.

DOC-06800 Rev. A DRAFT 5-9
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Placing To place an object on the build tray using stl, sic or files:
(B)Ltl)ﬂ?jc-tr?‘aoyn the Open the Insert dialog box —

* From the Object menu, select Insert.
or—

*  On the Tray Settings ribbon, click rsert .
or—

* Right-click on the build tray, and select Insert from the context
menu.

The Insert dialog box appears.
Figure 5-9: Insert dialog box

2. Inthe Look in field, display the appropriate folder.
3. In the Files of type field, select the file types to display (stl, slc, objdf).

4. Select the desired file, and make sure that it appears in the File name
field.

If the Preview check box is selected, the object is displayed in the dialog
box, as shown in figure 5-9.

Note: You can open several st/ files at once, to place several models on the
build tray. If you select multiple st/ files that make up an assembly,
you can select all or some of the parts. To print the entire model,
select all of an assembly’s component st/ files, and select the
Assembly check box. This positions the parts as a complete,
integrated model instead of as independent parts. The effects of
selecting the Assembly check box—in both the model tree and the
build tray display—are shown in the following figures.

el I res
= i e

Figure 5-10: Assembly check box selected—stl files are placed as an assembly
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Figure 5-11: Assembly check box not selected—st/ files are placed as parts

The Model Settings ribbon is displayed when objects are placed on the
build tray.

5. Select any of the following options, as required:
* Units —Millimeters or inches for the object’s units of measure.

The 3D file contains the object's proportions, but not its units of
measure. Therefore, make sure to correctly select either millimeters
or inches when inserting an object. Otherwise, the size of the object
on the build tray will be either much too large or much too small. To
change the measurement units of objects already placed on the tray,
see “Measurement Units” on page 33.

* Number of copies —How many copies of this object to place on the
build tray.

* Orient Automatically — Automatically orient objects on the build
tray for efficient model building.

* Assembly —Mark this check box if you selected multiple st! files
that are part of an assembly.

Note: The Extents values displayed in the Coordinates section of the Insert
dialog box, represent the maximum dimensions of the object on each
axis. These dimensions correspond to the virtual “bounding box”
surrounding the object see figure 5-51 on page 40).
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6. Click Insert.
Objet Studio places the object on the build tray, and in the model tree.

-

CEfat § adis: Conmes

# v b Q @, F | Bockat Cadbikde 4 =
Travy St I Job Hamages e - vew = fbect * ookt = Syl =
YRR oW P rme Pfoaligle K rem - E &8 M E
a o Sove Mrafom Lod | Y0 $5.00 T ks Avarced | b segurnta b e Seck doos B dnoened
= View* Tray Matensd

Seect —
et =
_E | Seetin Marsaine Direstecen ) [T gdern Mtigin Mikrwinh

M 1A VM2 117 0
ek L

Figure 5-12: Default screen layout

The Model Settings ribbon is displayed when objects are placed on the

build tray.
If the object is over a certain size, the Loading Placed Elements dialog box

may appear.

Loading Placed Elements

adel Mane IE:\...\.GHender\.Bin‘-.?ray'l .obitf

[ J

Placed Element IE:\...\.teslbuild.ubidf

[ |
Stop

Figure 5-13: Loading Placed Elements dialog box

You can speed up the opening of large files by changing the Large Files
settings—see “Loading Large Files” on page 44).
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Opening files

Before placing files on the build tray, Objet Studio must extract the

component st files together with information about their relative position
and model materials. To do this, Objet Studio creates a folder with the same
name as the file, in the same location.

L=k in: | =3 Samples

A

My Fecant
Lrazuments

@

Desktop

My Documents

My Carmputer

My Metwark.

[C)Basc Shapes
)chess
ﬂﬂCUrnex Sampes
(Z)Cornex_Samples
(C)Edan_nlariz_camplas
l'fi'jlmages

() sarrple fie
(5L Files

(C35TL Files

() Tesxk3D
aTravl

0

JDB Traxl

File hame: !Tray1

v

[ I et ]

Files of type: |Dhiet Digital =ilez

* abjdf] v

[ Cencel ]

Uits: | Millieter v

Murnber of Copies: |1 e ]

Coordnates
Width <] - Depth [r)
Extents |

Matericls

"] Miient autnmaticely

Height [Z]

Macked Assenbly Mle
Yercwhitz

Frevien

Figure 5-14: Insert dialog box (file)
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Opening Objet  You can open trays that were saved as objtf files. This is useful, for example,
Tray Files if you saved a tray after preparing it for printing, and now you want to
make changes before printing it.
To place an object saved as an Objet Tray File (objtf) file on the build
tray: Lj
1. From the File group, click open.
or—
From the Objet Studio Commands, select Open.

The Open dialog box is displayed.

Lzckn [ 3 Bodc s -
. Hmeu )
5 |omm
M Rec=nt
Liua:. et
s
Drezkior
)
My Cccumarts
Py Zompuez
‘i_f} ke rame s, wl Lzen
a1 =% —
My fctnor, | Fhultne [ Jbke:Tig, Fles (.ot e | Loics
Condratz:
e em

Figure 5-15: Objet Tray File Open dialog box

2. Select the desired file, and make sure that it appears in the File name
field.

If the Preview check box is selected, the object is displayed.
3. Click Open.
Objet Studio opens the tray file.

files to print and their position on the build tray. Because the objtf file
references the sil files used, they must remain in the same file location as
when the objtf file was saved.

% The objtffile is actually a file containing instructions for printing—which st/
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STL file loading If there are identically named st/ files in more than one location, you need
preference to ensure that the correct component st/ files are linked to the objtf file. For
example, if there are identically named st! files on one drive and on a flash
drive (this can occur if you copy the original files to a working folder), you

can set the default location from which files are loaded.

To set the Load Order:
1. From the Tools menu, select Options.

or—

In the Objet Studio Commands Menu, click Options.
2. Inthe Options dialog box, display the Settings tab.

| Appearanze | Giid | Manipulate | Jisplay | Setings |
Automatic Flacement

Quick Automatic Placement alter adding «ew object

Preseve - kB _ mm  dstance betyeen objects

Autornatic Lap Or [Gravity)
() Never

) Always

2 whien under the tray

Large “iles

&) Load Full
(D) Load Partial fis

oad Scarch Order
) Loeal
® Orginal

s ]

Figure 5-16: Options dialog box, Settings tab

3. Under Load Search Order, select an option:
* Local—to load files from the location where they were last saved.
* Original—to load files in their original location.

4. Click OK.
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Quick-Access
Model
Commands

Model Toolbar

Right-click model
menu

You can access common commands for working with objects on the build
tray with the convenient Model Toolbar and context menus.

Select an object in the tray to display the Model Toolbar that contains icons
to perform common tasks.

Poex®ad

FullZure? 20 x

Figure 5-17: Model Toolbar
The table below describes the Model Toolbar icons.

Icon Description

Applies a matte finish to the model.

Applies a glossy finish to the model.

Opens the Advanced Properties dialog box for setting the
Grid Style and the Hollow option.

R ©| @

Enables dragging an object (see page 5-34).

'Flﬁ

£
o Opens the Transform dialog box for changing the
‘LJ object’s position and scale.
l.li;..l Toggles the Lock Model Orientation setting.
p-g
TangobBlack+ . | Allows you to choose the printing materials.

Enables you to apply a coating to the model, or change
the coating previously applied.

©

If you right-click on an object, a pop-up context menu is displayed from
which you can also select the model finish, change its position and scale,
and set the Grid Style and Hollow options.

You can also create a Quick Access toolbar with your most commonly used
icons grouped together. See “Creating a Quick Access Toolbar” on page 60.
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Copying and If you need to duplicate objects on the build tray, you can insert the same

Pasting object from its file more than once. An easier way, however, is to copy and

Objects paste the object. You can copy objects from the build tray or the model
tree—individual or multiple parts or assemblies. The objects copied remain
in the Windows clipboard until you paste them onto the build tray.

You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another
one. However, Objet Studio allows only one tray to be open at a time. For
each build tray you need to work with (at the same time), you must open a
separate Objet Studio window, by running the application again (from the
Windows Start menu).

need to manipulate or configure objects before inserting them in your
production build tray. For example, if you need to change the model material
of an object (saved as an objdf file) to match the model material already
used in the production build tray, you must do so before inserting the
object—on another tray. Copying and pasting also allows you to use objects
already configured on previously-used build trays for newer projects.

Q Having multiple Objet Studio windows open can be convenient when you

You perform the Copy and Paste commands as in other Windows
applications:

* from the right-click context menu.
* by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).

The Paste Special command (from the object’s right-click context menu)
enables you to place duplicate objects even more efficiently:

* You can specify the number of duplicates to place on the build tray at
once.

* You can set the distance, on each axis, between the duplicate objects.

* You can manipulate mirror images of the original object, and flip them
on selected axes.

Murnber of Copies %
Drelta
x 100 ] [0 |z [0 | o
b aripLlate
Mlirmar [ Fle =z
Flip []= Pl =
[15ave as Defaults I Ok ] [ Cancel

Figure 5-18: Paste Special dialog box

DOC-06800 Rev. A DRAFT 5-17
16 June 2013



Using Objet Studio

Selecting
Objects

Splitting
Objects into
Components

To manipulate an object on the build tray or assign characteristics to it
(model material, building style etc.), you must first select the object. You
select an object by clicking it, either on the tray or in the model tree. Its
image on the build tray changes color (to light blue, by default) and its
name is highlighted in the model tree. You can select multiple objects by
drawing a box around them with the mouse cursor, or by pressing the Ctrl
or Shift keys while clicking additional objects.

Alternatively, select or de-select objects using the following Edit menu
commands:

* Select All
* Invert Selection
* Undo Select object
Edit =/view = object -
" 4 :

Undo Select objeck

Select all

Inwert Selection
Figure 5-19: Edit menu

Sometimes, you need to select individual elements of an assembly. Other
times, you need to select the entire assembly. The Selection icon displayed
on the ribbon determines what will be selected when you click on the
model:

e

W L

Saba L Select
Thenerk - Eroup -
G achior or Salactian

To change the selection action:
1. On the Tray Settings or Model Settings ribbon—
a. Click the Selection icon: E,; O sansiam -

b. On the flyout toolbar, click the appropriate icon:

Select Element

&
ol

Select Group

B

Figure 5-20: Selection flyout toolbar

You can convert a complex object to an assembly of component parts. To do
so, you split the st! file that represents the object into a group of separate stl
tiles, each one representing a component. (This is referred to in the Objet
Studio interface as separating the object into shells.) You can then assign a
model material to each st! file, and you can save the newly-created
assembly as an objdf file.
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To split an object into an assembly of component parts:

1. If the objectis not displayed, place it on the build tray by inserting its stl
file (see “Placing Objects on the Build Tray” on page 10).

The object appears—on the build tray and in the model tree pane—as a
single part. It is assigned, by default, the “primary” model material. (If
Objet Studio is configured with a secondary material, you can assign
it—or a digital material —to the entire object. This is explained in
“Model-Material Settings” on page 20.)

Figure 5-21: Object placed on the build tray from a single st/ file

Note: There is no need to resize or arrange the object on the build tray at
this time.
2. With the object selected:
* From the Object menu, select Separate into Shells.
or—
ﬂ‘% separate to shells
* On theribbon, click = .

A dialog box opens in which you can specify where to save the
component st files. (By default, Objet Studio offers to save the new files
in a folder in the same location as the original st! file.)

Separate to Shells

Save to Falder: :"-.Ei-' nple

Figure 5-22: Folder selection for saving st/ files after splitting into shells
3. Click OK.
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Objet Studio splits the object into an assembly of component parts, each
a separate st! file (“shell”).
The object appears—on the build tray and in the model tree—as an

assembly of parts (“shells”). You can assign each part a different model
material (This is explained in “Model-Material Settings” on page 20).

Mok 1rvw

Figure 5-23: Object after being converted to an assembly of component parts

Model-Material Before placing objects on the build tray in Objet Studio, you should pay

Settings attention to the material selection settings on the Tray Settings ribbon.
WeroBlack i Single Material
FullCure7 20 = V| Multiple Materials

currently loaded: WeroBlack, Vero¥White

Figure 5-24: Material selection settings

5-20

By default, the material selection settings on the ribbon correspond to
the model cartridges loaded in the printer.

The materials displayed are basic model materials. These materials can
later be combined to create digital materials (see “Digital Materials” on
page 21).

The material displayed on the top (VeroWhite, in the figure above) is
considered the primary model material (“Model-1”). It is assigned to
objects that do not have a material assignment when you place them on
the build tray. For example, since st/ files do not contain information
about the model material, Objet Studio assigns the primary model
material to them. Also, if you try to insert objdf files whose assigned
materials are not recognized by your version of Objet Studio, you can
insert the file by substituting the primary model material for the
missing materials.

Select Single Material if you want to print using only one material —
both of the material drop-down menus contain the same material. If
you decide to print with multiple materials, the material in the top
drop-down menu remains assigned to the object until you select
another material.

If you insert an objdf file into an empty build tray, and the model-
material assignment does not match the settings on the Tray Settings
ribbon, these settings are changed automatically. However, if there is an
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Changing the
Model Material

Digital
Materials

DOC-06800 Rev. A

object already on the build tray whose materials do not match the
material assignment in the objdf file, you cannot place the new object on
the tray. To print this object, you have the following options:

O Instead of printing it on the same build tray, print the new object as a
separate job.

O Change the materials assigned to objects on the build tray to match
those assigned to the new object (see “Changing the Model
Material” and “Assigning a Model Material to Objects,” below).

O Change the materials assigned to the new object before inserting it,
so there is no conflict with the settings on the Tray Settings ribbon.

To change the materials assigned to an object before inserting it:

1. Open another Objet Studio window, by running the application from
the Windows Start menu.

Insert the new object (objdf file) into the empty build tray.

3. Change the material selection settings on the Tray Settings ribbon to
those used on the other build tray.

4. Assign materials to the object (see “Assigning a Model Material to
Objects” on page 22).
5. Select the object and copy it.

Display the other Objet Studio window, and paste the object onto the
build tray.

Note: You can save the object with the new materials either as a new objdf
file, or by saving the original file with the changes.

When you design a build tray in Objet Studio, you can use model materials
that may not be currently installed in the printer. Because the installed
materials are displayed by default, change the material selection settings on
the Tray Settings ribbon, if necessary.

VeroBlad » Single Material
VeroWhite ™ ¥ | Muitiple Materials
DTengoGre, |

.-.leroslati )Biack, VeroWn

D VeraBlue |

D Verpliear

.r—l \'E[E\:[Ey |

]:l VeroWhitz -

When two different model materials appear on the ribbon, you can produce
objects from either material or from a combination of them —digital
materials. Different pairs of model materials enable you to print objects
using unique digital materials. Certain digital materials can produce
objects with different shades of color. Combinations of model materials
that have different mechanical properties result in digital materials with
unique characteristics.
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To view the digital materials available for printing objects (using two
basic model materials):

1. Make sure that you have selected the appropriate model materials, and
that Multiple Materials is selected.

JeroBlack = Single Material
FullCure720 = V| Multiple Materials

Currently Inaded: VernRlack, VeraWhite

Figure 5-25: Material selection with two basic model materials

2. Click &,

The Material Selection Guide appears, showing the basic model
materials (at the top of the list) and the digital materials available
(combinations of them).

Material Selection Guide

.I:lVemWh te [Generd Purpoze: High Jimensional Staaility, HO'T 43C]

I:| Db _85C5_Grey20 High Rigidty, Impact 25 J/m, Elongation at Bred: 15%-25%)]
l:l Mk _BR1N_Grew?R High Rigicdity, Impact 25,0, Flangation at Bred: 1TR%25%)
I:l Dibe_8515_Grey35 High Rigidty, Impact 25 J/m, Elongation at Bred: 15%-25%)
I:l Ditv_8520_Grey40 High Rigidity, Impact 25 J/m. Elongation at Bredk |5%-252)
|:| Db 8525 GreyS0 Balanced Jigidky. Impact 25 J4m, Elonaation at Break 20%-30%
:|:| Dibv_8520_Greysl PP-ike, Irpact 30 J/m. Elongaton at Breas 25%-35%)
- Drbe_0055_Shore9S (Mubber-lie, 5 aore A0S, Clongation at Dreak S0%)

;- Dibv_98E5_Shore85 [Rubber-ice, Sqore 485, Elongation at Break B07%)

:- Dite_9870_Shore70 [Rubber-li<e, Saore 470, Elongation at Break 757%)

- Dk _92E0_SharcEl (Rubber livz, Saore AR, Elongation at Breal 80%)]

- Dibe_98E0_Shorebl (Rubber-li<e, Saare 450, Elongation at Break 105%)
- Db _9840_Shored [Rubber-ice, Saore 440, Elongation at Break 125%]
- TangoBlack+ [Rubzerlike, Skore 427, Elongztion at Break. 218%)

Help

Figure 5-26: Material Selection Guide, showing the digital materials
available with the basic model materials

Assigning a You can assign any of the available digital materials to objects on the build
Model Material tray.
to Objects

To assign a model material to objects:
1. Select an object on the build tray (see “Selecting Objects” on page 18).

When an object is selected, its properties—including model materials—
are displayed on the Model Toolbar and on the ribbon.
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Figure 5-27: Object properties, on ribbon and Model Toolbar
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2. Display the material pull-down menu and select the desired material.
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Figure 5-28: Menu for assigning materials to objects

When you de-select the object on the build tray, it is displayed, by
default, with the color of the material you selected. In the same way,
you can assign model materials to each of the independent objects on
the build tray.

To separate an object into independent, component parts (each an st/ file),
see “Splitting Objects into Components” on page 18.

Models can be printed with a matte or glossy surface finish. To create a
matte finish, the printer surrounds models with a thin layer of support
material.

To set the model finish:

1. Select the model.

2. Select Matte @ or Glossy < in one of the following places:
* Model Settings ribbon, Options group
* Model Toolbar
* right-click context menu (when selecting the model)

You can configure Objet Studio to distinguish between objects’ surface
finish on the build tray by color. To configure how Objet Studio displays
objects, see “Setting Object Colors” on page 43.

You can print composite models where the surface layer is a different
material than the inside. This can be useful to achieve unique mechanical
and textural characteristics. This technique is called “coating.”

To coat an object with a different model material:

1. Select an object on the build tray. _

2. On the Model Toolbar or the Model Settings ribbon, click 9
The Coat with dialog box opens.
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3. Select Coat With and, from the pull-down menu, select the coating

4.

material.
Coat With
Coat Wwith:  FullCure7zo v |
Thickness: ' 1 : i
Lpply 1 [ Cancel

Figure 5-29: Coating material selected

In the Thickness field, enter a coating thickness between 0.3 and 3

millimeters.

Note: The coating thickness does not affect the external dimensions of the
object, which remain unchanged. The coating layer replaces part of

the main model material.

5. Click Apply.

Note: When you de-select objects, they are displayed, by default, with
colors representing the model-material. Even after adding a coating
to an object, its color remains that of the main material, not the color

of the coating material.

To inspect, modify or remove the coating applied to an object:
On the Model Toolbar or the Model Settings ribbon, click 0

1.

The Coat with dialog box opens.

Perform one of the following actions—

* Change the coating settings, and click Apply.

* To remove the coating, clear the Coat With check box and click

Apply.

* To keep the current coating settings, click Apply or Cancel.
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To enable you to assign materials and other properties to parts of objects
that are hidden from view on the build tray display, you can temporarily
turn off the display of some objects.

To prevent the display of objects:

1. Right-click an object, either on the build tray or in the model tree.

2. From the menu that opens, select one of the following options—
* Hide, to cause the selected object to disappear.

* Hide Others, to cause all other objects on the build tray to
disappear, so that only the selected object is displayed.

Alternately, you can clear the check box next to the name of the
object in the model tree to cause that object to disappear.

| P 1 Fiualel Tree

i : | |
([ Apptaiors - ieychier Sample_She Booiebons-Key bicer Sample Sheld |
| appiecbior (D B het® L I"I Badcatons « L1 Eace_sand ‘

Figure 5-30: All objects displayed Figure 5-31: Outer object hidden
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To produce models efficiently and with the required finish, it is important
to carefully position objects on the build tray. Objet Studio supports the
automatic positioning of objects. However, you should check to make sure
that the objects are orientated logically for your needs, according to the
considerations explained in “Model Orientation” on page 5-29.

Two things that affect the positioning of objects on the build tray are
orientation and placement. You can let Objet Studio determine the optimum
orientation and position, or you can control them.

By default, Objet Studio automatically orients objects, when placed on the
build tray, for the shortest printing time. (You can later change the
orientation manually.) However, you can cancel automatic orientation
when placing an object on the build tray.

To place an object on the build tray without automatic orientation:
» In the Insert dialog box, make sure Orient Automatically is not selected.
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Figure 5-32: Orient Automatically option disabled

You can change the default setting, so that automatic orientation is not
applied unless you select the Orient Automatically check box each time you
place an object on the build tray. To do this, see “Default Settings” on
page 66.
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After placing several objects on the build tray, you can let Objet Studio
arrange them on the tray for printing. This ensures that the objects are
positioned properly, and that they will be printed in the shortest time and
with a minimum of material.

To automatically arrange objects on the build tray:

» On the Tray Settings ribbon, click Pacement .
or—
From the Tools menu, select Automatic Placement.

The effects of automatic positioning are shown in the figures below.

Figure 5-33: Tray before objects are properly arranged
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Figure 5-34: Tray arrangement after applying Automatic Placement

Settings ribbon, even if you inserted the objects with the Orient
Automatically option.

* The physical characteristics of each type of model material you use can
affect the positioning of objects on the build tray. Therefore, select the
material before running Automatic Placement.

% * For best results arrange the tray with Automatic Placement, on the Tray

Manual You can change the position of objects on the build tray —even if they were

Positioning inserted with the Orient Automatically option. Considerations for
positioning objects are presented in “Model Orientation,” below. Tools for
changing the position of objects are presented in “Manipulating Objects on
the Build Tray” on page 5-30.
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The orientation of models on the build tray affects how quickly and
efficiently they will be produced by the 3D printer, where and how much
support material is used, and whether or not model parts will have a glossy
finish. Therefore, you should consider a variety of factors when deciding
how to place models on the tray, using the following positioning rules.

X-Y-Z Rule
This rule considers a model's outer dimensions.

» Since the print heads move back and forth along the X-axis, the printing
time along this axis is relatively short, compared to printing time along
the Y-axis and Z-axis. From this point of view, it is advisable to place the
object's largest dimension along the X-axis.

» Any surfaces that come into contact with support materials become
matte.

» Since high-resolution models are built up, on the Z-axis, in 16 or
30-micron layers (according to the selected printing mode, it is very
time-consuming to print a tall object. From this point of view, it is
advisable to place the object's smallest dimension along the Z-axis.

» Since the print heads measure about 2 inches (5 centimeters) on the
Y-axis, models measuring less than this (on the Y-axis) are printed in
one pass. From this point of view, it is advisable to place the object's
intermediate dimension along the Y-axis.

Tall-Left Rule

This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

» Since the print heads move along the X-axis from left to right, taller
sections on the right require the print heads to scan unnecessarily from
the left until reaching them. If, on the other hand, the taller sections are
positioned on the left of the tray, the print heads only have to scan the
model until printing these sections—once the lower parts have been
completed. Therefore, you should position the taller side of the model,
when possible, on the left.

The following rules are based on the fact that support material is not
required on the top of the printed model.

Recess-Up Rule

This rule considers models containing surface recesses.

» Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face-up.

Fine-Surface Rule

This rule considers models that have one side on which there are fine
details (like the keypad side of a telephone).

» The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.
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Avoid Support-Material Rule

This rule considers models that have large holes or hollows, open on at
least one side (like a pipe or a container).

» It may be advantageous to print a model standing up, so support
material does not fill the hollow, even though printing the model lying
down would be much faster.

Manipulating Objects on the Build Tray

Positioning
Objects on the

Z-Axis

5-30

R

When you use the automatic positioning option to arrange objects on the
build tray (see “Automatic Orientation” on page 5-26), the objects are
positioned directly on the tray. If you do not insert objects with automatic
positioning, they often appear either above or below the tray.

In practice, the Objet system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects
directly on the build tray with Objet Studio is to correctly display the objects
on the screen.

To position objects directly on the tray:

1. Select the object.
2. From the Object menu, select Lay On.

To ensure that objects are always positioned directly on the tray:
1. From the Tools menu, select Options, and display the Settings tab.

| Anneatare | frid | Manipulats | Jisnly | Settings |
Automatic Hacement

Quick Automatic Placement alter adding «ew object

Preseve | 1 | mm dstance betmeen objects

Automatic Lap Or [Gravity)
) Never
&) Always
) Wieh Lnder The tray
Large “iles

(%) Load Ful
) Load Martial (educsd)

Load Search Order
) Local

A
©*) Drginal D el aull,

l 0K, H Cancel ]

Figure 5-35: Options dialog box, Settings tab
2. Inthe Automatic Lay On (Gravity) section, select Always.
Other Z-axis options (in the Automatic Lay On section):

* When under the tray —The display of objects that are below the build
tray is automatically changed so that the object is at tray level.

* Never—The display of objects that are above or below the build tray is
not changed.
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Valid Object You can ensure that models do not overlap when you position them on the
Placement build tray, and that they do not extend beyond the tray.

To ensure valid object placement:

1. From the Tools menu, select Constraints Settings.

Conatrainis
Colars
Default Color
Outzide Tray

Collisian

il

Bath

|#] Dynamic check
“wihento check
(=) On Drop
(1 while Crag

“w'hat .o check
Olutside Tray
Dbiect Collision

Figure 5-36: Constraints Settings dialog box

2. Select Dynamic check to identify:
* invalid object placement while placing objects —On Drop selected.
* invalid object placement after moving objects —While Drag selected.
* objects placed beyond the tray’s boundaries — Outside Tray selected.
* objects that overlap —Object Collision selected.

tray, Objet Studio automatically checks if there is a problem with the
positioning of objects on the tray before sending it to the printer. You can
also manually check for problems after positioning objects (see “Tray
Validation” on page 47).

%( Even if you do not use Dynamic Check when placing objects on the build

Note: Because of the unique characteristics of each type of model material
and finish, always check valid placement after changing the material/
finish. Remember that Objet Studio calculates the space occupied by
an object including the “bounding box” surrounding it (see
figure 5-51 on page 40).

DOC-06800 Rev. A DRAFT 5-31
16 June 2013



Using Objet Studio

Using a Gridto Displaying a grid on the image of the build tray can be useful when

Position positioning objects. To use the grid features, select the following menu
Objects options.

Menu Option Result

Tools > Grid Displays a grid on the build tray.

Tools > Snap to grid | When moving the object, it aligns with the nearest

grid line.
Tools > Options > Enables you to change the grid origin
Grid (X- and Y-axis meeting point) and appearance.

You can review and configure grid settings—and apply them —from the
Options dialog box.

To view and change grid settings:
1. From the Tools menu, select Options, and display the Grid tab.
The current grid settings are displayed.
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Figure 5-37: Options dialog box, Grid tab

2. Asrequired, change the settings, and select or clear the check boxes.
3. Click Apply or OK.
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Measurement 3D files contain an object's proportions, but not its units of measure.

Units Therefore, make sure to correctly select either millimeters or inches when
inserting an object. Otherwise, the size of the object on the build tray will be
either much too large or much too small.

To set the measurement units when inserting an object:
» In the Insert dialog box, Units field, select Millimeter or Inch:

Insart

Lok ir: |;-::JSampes v| Q S i el o
N [Z)Bzsic Shapes
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My Recent |2 Connes: Samples
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[HSTL Files
() Text3D
3 Trayt
by Documents '::' et .
(-j sample file
tdy Carmmpuiter
‘I- } File: name: [ Insert ]
My Metwork | Files of type:

[ MiliMeter '

Figure 5-38: Units field in the Insert dialog box

To change measurement units for a selected object from the
Model Settings ribbon:

1. Open the Units flyout toolbar.

mm
|

Millimeter

-

E its

inch
| - e

Figure 5-39: Units flyout toolbar

2. Select the measurement units desired.

To change measurement units for a selected object from the Standard
Toolbar:

1. From the Object menu, select Change Units.

Willit =ter
I

Figure 5-40: Model Units dialog box
2. Inthe Model Units dialog box, change the setting and click OK.
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Setting Model
Dimensions

Repositioning
Objects

5-34

You can change an object’s dimensions by changing its size on the X-, Y-,
and Z-axes, from the Dimensions group on the Model Settings ribbon.

¥ 360 " Uniform Scale

Vo4 16
A i)
| Dimensians (mm) |

Figure 5-41: Dimensions on the Model Settings ribbon

* If Uniform Scale is enabled, changing the object’s dimension on one axis
affects the other dimensions, proportionately.

* After changing a measurement, press Enter or click in another filed in
the Dimensions group.

Note: You can change the height of the objects on the build tray only if this
is allowed by the Objet Studio settings (see “Positioning Objects on
the Z-Axis” on page 5-30).

You can manually move and rotate an object on the build tray with the

arrow keys, or by dragging it with the mouse.
To manually manipulate an object:
1. Select an object by clicking it on the build tray, or in the model tree
pane. _
W
2. Click pove on the Model Toolbar, or on the Model Settings ribbon.

A frame appears around the object, and the cursor changes to indicate
that the object can be moved.

FEN

Figure 5-42: Manually moving an object
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3. Ifyouclick on a corner of the frame, the cursor changes to indicate that
the object can be rotated.

Figure 5-43: Manually rotating an object

4. Manipulate the object with the arrow keys or with the mouse.

Using the Transform You can make precise changes to an object by changing the properties in the
Dialog Box Transform dialog box.

W

DOC-06800 Rev. A

To access the Transform dialog box (when an object is selected):
* Click WJ on the Model Toolbar or on the Model Settings ribbon.
* From the right-click context menu, select Transform.

* From the Object menu, select Transform.

lranstorm x]

WidhX)  DeptlY) Heigi2)
Transate:l g :| |D :| |

Rotte |2 2] [0 2] [82]

i T TR T
Geale |1 v| |1 v| I1 v|

Unifarm S calng Apply Reset
Caneel Actons

Figure 5-44: Transform dialog box

To change an object with the Transform dialog box:

» Change any of the values, then click Apply to see how the object
changes on the build tray.

Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see
how the object changes on screen each time you click Apply.

To reset all of the values in the dialog box:
» Click Reset.
Note: The object does not change. Any changes previously applied remain.
To undo all changes made with the Transform dialog box:
» Click Cancel Actions.

After closing the Transform dialog box, clicking Undo (on the Model Settings

ribbon or from the Edit menu) cancels all changes made with the dialog box.
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There are several methods for changing the orientation of objects on the
build tray.

To rotate an object:

> Select the object and use the Object menu options (see also
“Repositioning Objects” on page 5-34).

To re-align an object’s plane:

1. On the Tray Settings or Model Settings ribbon—
b b

Leect Select
“kent aroup T

a. Click the icon in the Selection group: ... Or wiw .
b. On the flyout toolbar, click the Select Plane icon:

Select
Elzment =

felki chion
el

By .-'ﬁ-.l
Vgt

From the Tools menu, select Plane Alignment > Select Plane.
2. Click on part of an object on the build tray.

The selected plane is displayed.

Alignment
toolbar

Selected
plane

Figure 5-45: Aligning by plane

3. On the Alignment toolbar, click an appropriate icon to change the
alignment.

or—

From the Tools menu, select Plane Alignment, and select an alignment
option.
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Figure 5-46: Tools menu, Plane Alignment options

To cancel plane selection after re-aligning objects on the build tray:

» On the Tray Settings or Model Settings ribbon—
® @

teert Seleck
Zhamgnt e Aroup T

a. Click the icon in the Selection group: ... O sicw -

b. On the flyout toolbar, click the Select Element or Select Group icon:

=2

Select
Plang =

From the Tools menu, select Plane Alignment > Select Plane.

To flip an object 180 degrees on any axis:
1. Select the object.
2. From the Object menu, select Flip > Flip X/ Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:
1. Select the object.

2. Display the Transform dialog box (see figure 5-44 on page 35).
3. Change the Rotate parameters for each axis.

You can manipulate two or more objects on the build tray, at the same time.
* Selecting multiple objects

Manipulating done to one object affects all selected objects. For
example, turning one object on its axis causes all selected objects to turn
on their respective axes.

* Converting the objects to an assembly

Separate objects become parts of one unit. For example, turning the
assembly on its axis causes all its component parts to turn as one unit.

To convert objects to an assembly:
1. Select the objects (see “Selecting Objects” on page 18)
2. From the Object menu, select Group to Assembly.
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In the model tree, the objects now appear as children of a parent
(assembly).

Model Tree
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Figure 5-47: Assembly in the model tree

After creating an assembly, you can save it as an objdf file, for re-use.
(Saving the assembly is not necessary for manipulating and printing it).

To save an assembly:
1. Select the assembly (either on the build tray or in the model tree).
2. From the Objet Studio Commands, select Save As.

3. In the Save As dialog box, select the objdf format, choose a location,
name the file, and click Save.

To separate assemblies into individual objects (st/ files):
1. Select the assembly (either on the build tray or in the model tree).
2. From the Object menu, select Ungroup.

In the model tree, the elements are not parts of an assembly.

Model Tree

= @@ Tran

1] Slider

v | Pocket Card Holder_Shelll
[w| | Pocket Card Holder_Shell2
[ _| Pocket Card Holder_Shell3
|| | Pocket Card Holder_shelld
[v] | Pocket Card Holder Shells
v | Pocket Card Holder_Shells
[w| | Pocket Card Holder_Shell?
[ _| Pocket Card Holder_shells

Figure 5-48: Separate objects in the model tree

If you manipulate an object on the build tray, you can freeze its orientation
so that it does not change when you position it automatically (see
“Automatic Placement” on page 5-27).

To freeze an object:

1. Select an object on the build tray.

2. On the Model Settings ribbon, in the Manipulate group, or on the Model
Toolbar, click .

To unfreeze an object:

» Select the object and click & (to de-select it).
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Display Options
Viewing From the View menu, you can change the way objects are displayed. The
Objects default method for displaying models on the build tray is as solid
(“shaded”) objects.

Figure 5-49: Tray and model displayed in Shaded view

The other display options are WireFrame and Points.

To display the build tray in WireFrame view:

» From the View menu, select WireFrame.

Figure 5-50: Tray and model displayed in WireFrame view

To revert to the shaded view:

» From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions
instead of their shape:

» From the View menu, select Display Bounding Box.

IS

Figure 5-51: Model displayed with bounding box

To display the area around objects needed for support material (to
produce a matte finish):

» From the View menu, select Display Thickening Box.

Figure 5-52: Model displayed with thickening box

To display the maximum build height:
» From the View menu, select Display Tray 3D Box.
Figure 5-53: Tray 3D Box

To display objects without the build tray:
» From the View menu, clear (de-select) the Display Tray option.
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Screen Layout Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models
from different perspectives by changing the screen layout.

To change the screen layout:
» On the View flyout toolbar, select Single View, or 4 Views.

Figure 5-54: Screen layout icons
O Single View is the default screen layout.
O 4 Views displays perspective, top, front and right views.

Figure 5-55: Single-view screen layout
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Figure 5-56: 4-view screen layout
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Tray The default perspective of the build tray is “isometric.” You can change the
Perspective perspective of the active window with one of ten options.

To change the perspective of the build tray in the active window:
1. On the Tray Settings ribbon, open the Perspective flyout toolbar.

ik 1®

HREELTER
HR%

Figure 5-57: Perspective flyout toolbar
2. Click the icon that represents the desired perspective.

Tray Positioning To view the tray and models from different directions, you can move the
tray around the screen and change its display angle.

To move the tray in the Objet Studio screen:

» Press the mouse wheel while moving the mouse.

-

S YA b T e

Figure 5-58: Tray after moving it in the Objet Studio display
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To manually rotate the tray:

» Press Alt and press the mouse wheel while moving the mouse.

.-p/“ﬁ\

P52 T O ot |

Figure 5-59: Tray after rotating it upside-down

The color of objects on the build tray can indicate how they are printed.
Objet Studio enables you to choose the color display so that you can easily
see the material, surface and coating of objects.

To choose how colors are applied on the display:

» On the Model Settings ribbon, in the Colors group, select one of the
options from the flyout toolbar.

é%
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/Color indicates Model surface
.
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O

Flgure 5-60: Colors display options

Before sending a build tray to the printer, or when you perform tray
validation, Objet Studio checks if there is a problem with the st/ files or the
positioning of objects on the tray. If so, the affected objects are displayed
with special colors (see “Tray Validation” on page 5-47).
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Loading Large  Very large st files can be slow to load and may be difficult to manipulate

Files easily on the build tray. If this is the case, you can display just an image of
the object on the build tray without loading the entire file. The st/ file itself
is not changed, and the complete file is sent to the printer.

To display an image of st/ files when you place objects on the build tray:
1. From the Tools menu, select Options, and display the Settings tab.
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Figure 5-61: Options dialog box, Settings tab

2. Inthe Large Files section, select Load Partial (reduced).

Large File If you need to work with a detailed model that is composed of a large

Manipulation number of polygons, you can speed up its display and manipulation in
Objet Studio by reducing the number of polygons on the screen. Although
this may reduce the resolution on the screen, it has no affect on the printed
models.

Figure 5-62: Object displayed without polygon reduction

Figure 5-63: Object displayed with only five percent of its polygons showing
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To use polygon reduction:

1.

From the Tools menu, select Options.

or—

In the Objet Studio Commands Menu, click Options.
In the Options dialog box, display the Display tab.
e )
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Figure 5-64: Options dialog box, Display tab

Select Enable Polygon Reduction.

Select Polygon Reduction (Percent).

Enter the percentage of total polygons to display.
When you click Apply, the display changes.

Note: The setting affects the static display (when the object is not being

moved).
Set display options when the object is being moved (Display while
changing view):

* Bounding Box—A box representing the object’s maximum
dimensions is displayed.

* Adaptive Polygon Reduction —Varying degrees of polygon reduction
are applied, as necessary.

* Entire Object—No polygon reduction is applied.

To save these settings, so that they will be applied every time you place
this object on the build tray, click Save Polygon Reduction Data.

Click Apply to see the results of the settings without closing the dialog
box.

%( Selecting the Entire Object option cancels polygon reduction.
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Object display The display format affects how quickly objects display. For example, if you
options  select Bounding Box, objects display faster than they do when you select
Entire Object. You can choose display formats for objects when they are
stationary (static view) and for when you are dragging them (changing view).

To select the object display preference while changing view, and in static
view:

1. Select to display objects:
* With a Bounding Box (see figure 5-51 on page 40)
* With Adaptive Polygon Reduction (changing view only)
*  With Polygon Reduction (static view only)
* Entire Object
2. Click OK when done.

Zoom Options  While manipulating objects, you often need to view them at different zoom
levels.

To change the zoom level:

» On the ribbon, open the Zoom flyout toolbar and select an option:

Zoom by Rectangle

Figure 5-65: Zoom flyout toolbar

3 Zoom Object focuses on the selected object.
3 Zoom Tray displays the whole tray.

3 Zoom by Rectangle allows you to display a section of the tray by
selecting it with the mouse.

You can also zoom in and zoom out with the mouse wheel.

You can configure Objet Studio to automatically zoom in on the objects
placed on the build tray. See “Automatic Zoom” on page 66.
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Handling Completed Trays

After you have properly placed all objects on the build tray, you save the
tray as an objtf file, which is sent to the 3D printer for production. But before
saving the tray, you can check that there would be no problem producing it.
You can also calculate how much material would be consumed during
production and how much time this would take.

Tray Validation Before sending a job to the printer for production, you should check that
the tray is “valid” and can be printed.

Note: Because of the unique characteristics of each type of modeling
material, make sure that the correct material is selected before
performing Tray Validation.

To validate that the tray can be printed: fe

» On the Tray Settings ribbon, in the Build Process group, click validsts .

or—
From the Tools menu, select Placement Validation.

If the tray is not valid, the color of the problematic models on the tray
changes according to a pre-set code.

Corstrainls
Colars
Default Color
Outzide Tray
Collisian

Bath

il

|#] Dynamic check
“wihento check
(=) On Drop
(1 while Crag

“w'hat .o check
Olutside Tray
Dbiect Collision

Figure 5-66: Color code

Note: The “Both” color also indicates a problematic st/ file.

The validation status appears on the bar at the bottom of the screen.

Walidation succesded Models; 1

Figure 5-67: Validation details in status bar
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Production
Estimates

Printing Modes
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Objet Studio enables you to calculate the time and material resources
needed for producing trays before sending them to the printer. The time it
takes Objet Studio to perform this calculation depends on the number of
objects on the tray and their complexity. Calculating the production
estimate for a full tray could take up to 15 minutes, depending on your
computer’s specifications.

To calculate the time and materials needed for producing the current
tray: Jn

» On the Tray Settings ribbon, in the Build Process group, click Estmate .

While the estimate is being calculated, a progress bar is displayed —on
the right side of the status bar (at the bottom of the screen).

.

CCI LI | — Cancel

Figure 5-68: Estimate progress bar

When Objet Studio finishes calculating the production resources, the
results are displayed in a dialog box.

Production Estimates PX|
| Printing Mode FullCaae=7 20 Crwna arnpine Supnnrt "rnsonaptioe Ruaild sirve i
! High Gluality 114q 483 02:19
| High Spead 103 g 373 01:25
| Digital Material 107 g 3Gy 02:39
!
[ Hmen | [ ok ]

Figure 5-69: Production resource calculations for different printing modes

As shown in the Production Estimates dialog box, the resources needed for
producing the models on the tray depend on the printing mode used by the
printer when producing the job. You might want to consider these
estimates when deciding on the printing mode (see below), and whether or
not to allow using substitute model materials when printing the job.

Note: You select the printing mode and material substitute options after
you send the build tray to the printer (see “Printing the Tray File” on
page 50).

Objet printers can build models using three possible printing modes.
HQ (High Quality) Mode—

* Models are printed in 16-micron layers, resulting in smooth surfaces,
suitable for producing fine-detailed and delicate items.

* Almost twice as much time is required to print most trays, compared to
the High Speed setting.

* This setting is only available when model material can be used in four
print heads, in single-material printing.
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Single-material printing: All print heads print models without regard to the
source of the model material. This happens in the following situations:

* All print heads are supplied with one model material.

* Each pair of print heads is supplied with a different model material, but
models are printed as if they were the same material. The result is an
arbitrary mixture of materials in the printed model.

HS (High Speed) Mode—

* Models are produced in 30-micron layers, suitable for producing larger
models.

* Much less time is required to print most trays, compared to the
High Quality setting.

* This setting is only available when model material can be used in four
print heads, in single-material printing.

Digital Material Mode—

* Used when producing models designed to be fabricated from two
model materials.

* Used when producing a tray containing two or more models, each
designed to be made from a different (single) model material.

* Used when producing models from only one of the model materials
loaded in the printer by printing with only two of the print heads.

* Models are produced in 30-micron layers, but the printing is near-high
quality.

* Printing time is similar to printing time in High Quality mode.
Although printing time is longer than with High Speed mode, Digital

Material mode can make material replacement unnecessary —saving
both time and the cost of wasted model material.

Digital Material Mode is selected automatically when more than one model
material is assigned to objects on the tray.

You can see estimates of time and material resources needed for printing
trays using the different printing modes (see “Production Estimates” on
page 48). You also see these production estimates when you send the tray
to the printer. At that time, you can select the printing mode, including an
option that enables Objet Studio to print the tray by the most efficient
method (see “Printing-Mode Selection” on page 50).

You can easily e-mail objdf files using Microsoft® Office Outlook®. Sending
objdf files is recommended (instead of st files) because the size of a file is
typically reduced by more than half. An added benefit is that the objdf file
contains the model-material information for the object.

To e-mail a file:

1. From the Tools menu, select Email Objet Digital File.

Outlook opens with the file attached and Subject details added to the
e-mail form.

2. Enter the e-mail address and send the file.
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Printing the
Tray File

Printing-Mode 2.

Selection

5-50

When a tray is ready to be printed, it is placed in the Jobs Queue. When the
job reaches the head of the queue, Objet Studio pre-processes the tray file to
create slices, and feeds them to the 3-D printer.

To send the tray to the print queue: £
1. On the Tray Settings ribbon, Build Process group, click euid.

two model
Jeh Sommary gl
This Job will be printad in Digital Material ™
My oo T Solivnules:
Fi iy e  FulZeTE0 Zomn i Bk Towlion | SawolCoadon 3dutne |
[T R 42y B ey =34
Hela [ Rald | [ Ceanrel

materials

Figure 5-70: Job Summary when printing with multiple model materials

Note: The values displayed are the result of a quick calculation, and
represent a rough estimate of the materials and time input required

to print the job. For a more accurate calculation, click Fine
Estimation.

Continue with step 4 on page 5-53.

* If printing the tray requires only one model material, the Printing
Mode Selection dialog box opens.

Printing Mode Selection

Select Mrating Mods

(High Cualty (IHign Sased =l Autematic

Ifatzrial end T me Estirates

Buldtine |

Frinting Mode FullCure?20 ZonzLmptior Suppot Consumption
High Guality 8By FEX: | 0215
High Spaad ‘ihg Ty 01:22
Digita Materal 143 y 7dqg 0237
’ Finc Ectimation ]
I Help ‘ | et I Cancel I

Figure 5-71: Printing Mode Selection dialog box

Note: The values displayed are the result of a quick calculation, and
represent a rough estimate of the materials and time input required
to print the job. For a more accurate calculation, click Fine
Estimation.

Select the appropriate printing mode.

* Ifyourequire the job to be printed in High Quality mode, select this
option.

Note:The availability of High Quality mode depends on the material
selected.
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* If you require the job to be printed in High Speed mode, select this
option.

* If you do not require the job to be printed either in High Quality or
High Speed mode, select Automatic.

This setting enables the Objet software to determine (just before
printing) the most efficient way to print the tray. Digital Material mode
is used if this removes the need to perform the Material Replacement
procedure. Otherwise, High Speed mode is used.

For example, if printing the tray requires only one of the model
materials loaded in the printer, only the two print heads using that
material are used to print models—Digital Material mode. (High
Quality and High Speed modes call for printing model material with
four heads, which would require you to perform the Material
Replacement procedure.)

On the other hand, if printing the tray can be done using four print
heads without running the Material Replacement procedure, High
Speed mode is used. This is possible if all print heads are supplied with
one model material, or if you allow printing with an arbitrary mixture
of similar materials (see below).

Model Quality When Digital Material Mode is Used

Near-high-quality is achieved for most models.

A tray of objects inserted from st/ files are printed with the standard
600 dpi (dots per inch) resolution along the Y-axis—unless glossy finish
is required (see “Surface Finish” on page 23).

If there is an assembly on the tray, all of the models on the tray are
printed with a resolution of 300 dpi along the Y-axis.

3. Click Next.

The Model Material Substitution dialog box opens—if this is relevant for
the tray. (If not, the Job Summary dialog box opens—continue with
step 4.)
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Model Material
Substitution Model Material Substilution

Can another model material be used instead of the
one you selected?

O Yes, use any material with similar charactaristics.
&) Na, use OMLY the selected model matetial.

| Back | | Bug | |[cancel| | Hep |

Figure 5-72: Model Material Substitution dialog box

If you allow the use of substitute model materials, the printer will use
different materials whose characteristics (strength, flexibility, etc.) are
similar to those of the material you assigned to the object when
designing the build tray —under the following conditions:

* The material you assigned is not installed in the printer at the time
of printing.

In this case, the tray is printed with either one or two substitute
materials (depending on the materials installed in the printer at the
time of printing). If possible, High Speed mode is used.

* In addition to the material you selected, there is another (similar)
material installed in the printer at the time of printing.

In this case, High Speed mode is used, by printing with a mixture of
the two materials (as if they were the same material).
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4. Click Build.

If the build tray file has not been saved, the Save As dialog box opens for
you to save it now.

Objet Studio checks if there is a problem with the positioning of objects
on the tray. If so, the affected objects are displayed with special colors
(see “Tray Validation” on page 47), and a warning message appears.

Warning

Overlapping ohjects!
- Click Mo to separahe objects manually
ar with Automatic Placement.

- Click Yes to print the tray a3 is.

Do vou watk ko procesd anmman’?

Figure 5-73: Tray validation warning message

* To cancel the Build command so you can correct the problem, click
No.

* To print the models as they are positioned on the tray, click Yes.
The Job Manager screen opens, so you can monitor the progress of your

trays—before, during, and after printing. See “Monitoring and
Managing Print Jobs” on page 72.
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Applying Additional Objet Studio Features

Dividing
Objects

5-54

You can use the Split Object feature to produce objects larger than the tray
area by dividing the model into separate parts. With this feature, you
produce only a specific section of a model.

To split an object:

1.
2.
3.

Select the object.
From the Object menu, select Split.

In the Split Object dialog box, enter the values to determine how Objet
Studio will divide the object. You can divide an object along any of its
axes, by entering either exact measurements or the number of parts.

| Muded Trase
(g

| fppicaiars - FLLTE_Shali_PattlL
| | trplicatiors - 1T el _Paits

ec: Loe St
Giopthpaz (3 | 22 | [ o
Citdibetaba [ || 1

Figure 5-74: Split Object dialog box
In Save to Folder, enter the folder name.
Click OK.

The composite parts are saved as new st files with “Part 1,” “Part 2,”
etc., added to the original file name.

Note: Before printing the newly created st/files, it is recommended that you

check them for defects in an STL-repair application, such as
Magics™, by Materialise®.
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Choosing the =~ When producing models, support material fills some hollow and empty

Support sections (see “Model Orientation” on page 5-29). Objet Studio allows you to

Strength adjust the strength of the structure formed with the support material. This
adjustment is useful when producing either large/massive models or small/
delicate models. For most purposes, the default setting provides adequate
support strength.

To change the strength of the support structure used when printing a
model:

1. Select a model on the tray.
2. On the Model Settings ribbon, in the Options group, click € .
or—
*  On the Model Toolbar, click = .
or—
* From the right-click context menu, select Advanced Properties.

The Advanced Properties dialog box opens.

Advanced Properties @

Gind Style [ Hellow
(%) Standard

D HeEawy
() Lite

| Apply

Figure 5-75: Advanced Properties dialog box

3. In the Grid Style section, choose the support strength suitable for the
selected model. You can select a different support strength for each
model on the tray.

* Standard—for models needing average support (most models).
* Heavy—for large models needing much support.

* Lite—for delicate models needing little support. (This setting makes
it easy to remove the support material.)

Note: If an object is split into shells, the Advanced Properties enabled vary
with the object selection. If a single element is selected only Hollow
is enabled. If a group of elements is selected only Grid Style is
enabled.

4. Click Apply.
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“Hollow"— Many objects placed on the tray from st! files are “solid.” This means that,

Filling Models  when printed, the model will be completely filled with model material.

with Support Often, especially with large objects, this is unnecessary. Instead, the model

Material can be filled with support material, which is less costly. It is also advisable
to fill models with support material when preparing them for investment
casting, since this material burns off more quickly during the process of
making the cast.

Objet Studio enables you to print objects on the tray with an outer shell of
model material and a center filled with support material. When using this
feature, called “Hollow,” the thickness of the shell should be no less than
0.5 millimeters.

To use the Hollow feature:
1. Select a model on the tray.
or—
*  On the Model Toolbar, click % .
or—
* From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.
2. Select Hollow.

Advanced Properties

Grd Stee |+ Hallaw

(2) Standard

() Heavy Chel Thicknes: | 1.35
O Lite ' '

Figure 5-76: Advanced Properties dialog box

3. Set the shell thickness, in millimeters.

4. Click Apply.

Note: There is no change in the display of objects in Objet Studio when
Hollow is selected.

To inspect, change or cancel the Hollow setting:

1. Select a model on the tray.

2. Access the Advanced Properties dialog box, as above.

3. If you change or cancel the Hollow setting, click Apply.
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The Section feature enables you to view the interior of an object by “slicing”
it on any axis. You can then manipulate the object to inspect the interior
from different angles. This may be important for deciding on the type of
support necessary when producing the model (see “Choosing the Support
Strength” on page 5-55). Displaying an object’s cross section only affects
how the tray is displayed on the screen; it does not change the object itself.

To display a cross section of the tray:
1. From the Tools menu, select Section.

The Section dialog box opens.

Section

Section l

| |

Iw Erable Clipping

Figure 5-77: Section dialog box

Select Enable Clipping.

Use the slider controls for the X-, Y-, and Z-axes to cut the tray so that
you see the cross section you want.

Figure 5-78: Whole view Figure 5-79: Cross-section view, after
using the Z-slider
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You can save the image displayed in the active viewing screen as a graphic

file.

To save the screen display as an image:

1.

IS

Press Ctri+B.

or—

From the Objet Studio Commands Menu menu, select Save Bitmap.

The Save Bitmap dialog box opens.

Savein |J 5T _File

I 2-0096

hz-0146

e spplications - ~ak Coating berp
!* Iraws Erp

-
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Save aztype: [

\Aprlicatiors - Tab Coating

Ainccvs Bimap [Fbmp]

DaAaT e RG3 TrieColor (24-bi

[+] |4

Covpreszert | Non-Zorpressed
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Figure 5-80: Save Bitmap dialog box

At the top of the dialog box, select the appropriate folder.

At the bottom of the dialog box, enter a file name.

Open the Save as type pull-down menu, and select the file format.

Click Save.
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When you save build trays in Objet Studio, they are saved as objtf files.
These files contain instructions to Objet Studio and to Objet printers for
displaying and producing the st! files used on the tray. To conveniently
save all of the files that comprise the build tray, for storing the job, or for
transferring it to another location, Objet Studio compresses them into one
objzf file. To later use the objzf file, the file must first be expanded in Objet
Studio and its component files saved.

Note: If you export an objzffile containing a st/ file originally saved as read-
only, you cannot open (import) this objzf file to the folder where the
read-only st file is saved.

To create an objzf file:

1. From the Objet Studio Commands Menu menu, select Export Packed
Job.

The Save As dialog box opens.
2. Select the appropriate folder and change the file name (if necessary).
3. Click Save.

To open an objzf file:
» Double-click on the objtf file.
or—

1. From the Objet Studio Commands Menu menu, select Import Packed
Job.

2. In the Open dialog box, display the appropriate folder and select the
file.

3. In the Browse for Folder dialog box, display the folder in which you
want Objet Studio to expand the compressed file, and click OK.

The objtf file and associated st! files are expanded and placed in the
selected folder, and the tray is displayed in Objet Studio.

Note: You can also export a print job as an objzf file from the Job Manager
screen—see “Exporting Jobs (objzf)” on page 83.
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Customizing Objet Studio

You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:

* Creating a quick-access toolbar for frequently used commands.

* Changing the position of the Quick Access toolbar.

* Minimizing the ribbon.

* Changing the Objet Studio color theme.

* Configuring default settings for objects placed on the build tray.
Creating a As you work with Objet Studio, you may use certain commands frequently.

Quick Access You can create a quick-access toolbar to make your work easier.

Toolbar To create a quick-access toolbar:

1. Above the ribbon tabs, click = .
The Customize Quick Access Toolbar menu opens.

l;i

Customize Quick Access Toolbar
Insert
Plavenmzil
Eckimate
Build
open...

Mnre Commands. ..

Showe Below the Ribbon

Mirirze the Ritbon

Figure 5-81: Customize Quick Access Toolbar menu
2. Select a command you want to add to the toolbar.
An icon for the selected command is added to the toolbar.

A
= Tray Settings Jobs Mana

b e ¥ S

Insett | Placement Yalidate Estimzte Euid

el Rl Prareas

Figure 5-82: Quick Access toolbar

To add another command, repeat the above procedure.
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5.
6.

To choose from a wider range of commands:

* From the Customize Quick Access Toolbar menu (see figure 5-81 on
page 60), select More Commands.

or—
* Right-click on the Objet Studio Commands icon, or elsewhere on the
ribbon, and select Customize Quick Access Toobar.
Customize Quick Aocess Toolbar...

Show Quick Access Toolbar Below the Ribbon

Minimize the Ribbon

Figure 5-83: Right-click ribbon menu
The Options dialog box opens.
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Figure 5-84: Quick Access Toobar Options dialog box

Open the drop-down list and select either Popular Commands or
Commands not on the Ribbon.

Select a command and click Add.
Click OK.

To make more room for displaying the build tray, you can hide the Objet
Studio ribbons.

To hide the ribbons:

1.

Right-click anywhere on the ribbon or on the menu bar, or in the Objet
Studio Commands Menu () -

Select Minimize the Ribbon.

The ribbons disappear, but you can temporarily display the ribbon
icons by clicking Tray Settings or Job Manager on the menu bar. When
you next click outside of the ribbon, it disappears again.

To return the permanent ribbon display:

» Repeat the steps above to cancel Minimize the Ribbon.
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Display Colors  You can customize some of the colors used for displaying Objet Studio
screens and for displaying objects on the build tray.

To change the colors used in Objet Studio screens:
1. From the Tools menu, select Define Colors.
The Define Colors dialog box appears.

2. Inthe Define Colors dialog box, click the color patch you want to
change:

* Tray Color
* Background Colors

* Selection Color
Define Colors EI

Click the color patch vou want o chanage,
and in the dialog box that opens,
zelect a calor from the menu.

Trap Color |:I
Backaraund Colars :] |:]
Selection Calor :l

(33 Show Color &coording to Material
() Colar Accarding ko Finish

[ ak J [ Cancel ]

Figure 5-85: Define Colors dialog box

3. Inthe Color dialog box, select one of the Basic colors.

or—

Click Define Custom Colors to expand the dialog box and define a
customized color.

B azic colors: |
el I B0 B
HMTFEFEEN '
HE NN N NN
EfNEEEEEN
EEEEEEEN
B B § § Bl i
Custom colors:
EEEEEEEN - = o
| Hue: 143 Hec:|212

J—!—J—]—!_“I—!_“l_ | Sat:ﬁ Eleer:é

Define Custom Colore 3 EolarlZalid )y E Blue:
’ ]S ] ’ Cancel ] ’ Acd to Custom Colors ]

Figure 5-86: Color dialog box (expanded)
4. Click OK when done.

The patch color in the dialog box changes according to your selection.
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Objet Studio offers a choice of four background color themes—blue, black,
silver and aqua.

@
- A B e

Ay

Figure 5-87: Background color themes

To change the color theme:

* From the Style menu, select one of the options.

You can define shortcut keys for frequently used commands.

To define shortcut keys:
1. Above the ribbon tabs, click = .

The Customize Quick Access Toolbar menu opens.

E

Customize Quick Access Toolbar

Insert
Flacement
Estimate
Build
UpEn...

More Commands...

Show Below the Ribbon

Minimze the Ritbon

Figure 5-88: Customize Quick Access Toolbar menu
2. Select More Commands.
The Options dialog box opens (see figure 5-84 on page 61).
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3.

6.

Click Customize.
The Customize Keyboard dialog box appears.

Customize Keyboard E
Catzgorcs: Commands
[ (I - |

Frivl Proiow Buld 2-cpetize |
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Figure 5-89: Customize Keyboard dialog box

Select command Categories to display all the commands in that
category, for example, all the Model Settings commands.

Current shortcut keys are displayed.

Enter the shortcut key in the Press new shortcut key field, and click
Assign.

If you want to redefine all shortcut keys, click Reset All.

You can change several Objet Studio settings that affect objects placed on
the build tray.

To change default settings:

» From the Objet Studio Commands Menu, select User Preferences.
User Preferences E|
Building Skye Grid Style
(%) Makte (*) Standard
) clossy CIHezvy
CLite
toplication Settings
[ Lack Gricntation
[ Foliow e
Figure 5-90: Setting work preferences
* Building Style—see “Surface Finish” on page 23.
* Grid Style—see “Using a Grid to Position Objects” on page 32.
* Application Settings—see “Choosing the Support Strength” on page 55,
and “Freezing Model Orientation” on page 38.
Coating Objects

DRAFT DOC-06800 Rev. A
16 June 2013



Objet1000 - Connex 2 User Guide

Professional Mode Features
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Some advanced features of Objet Studio are only accessible in Professional
Mode.

To see the current Objet Studio setting:
» Open the Tools menu.

Tools 'gs:yle > 0' '|

iatid
Snap ko Gid

Constraincs Settings. ..

Seckion
Flane Aligament »

¢ | Drofessional Made

LangJage. ..

Cpkions, .

Deline Cuurs,
Figure 5-91: Tools menu, showing Professional Mode selected
If Professional Mode is selected, advanced features are displayed.

To change the Professional Mode setting:
1. From the Tools menu, select Professional Mode.

The following message is displayed, reminding you that the change
will only take effect the next time you open Objet Studio—even though
the check mark next to the Professional Mode option appears
immediately.

I ‘j The configuration changes you have made will not take effect untl the next time you run the application.

Figure 5-92: Configuration-change message

2. Close and re-open Objet Studio to use the Professional Mode features.
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Default
Settings

Automatic
Orientation

Automatic Zoom
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You can control the default settings of several Objet Studio features from
the Advanced tab of the Options dialog box.

To display the Options dialog box

» From the Tools menu, select Options.

or—
In the Objet Studio Commands Menu, click Options.
Options E|
Appesrance || Grid anipuilate Display
Setlings | Advanced | T-oubleshooting
[ buste Zoarr

Drien: Obiects dutamaticalls

[ )3 ][ Cencel ]

Figure 5-93: Options dialog box, Advanced tab

By default, when Objet Studio places objects on the build tray, it orients
them optimally, for the shortest printing time. If necessary, you can choose
to cancel automatic orientation each time you place an object on the build
tray (see “Automatic Orientation” on page 26). In any case, when objects
are on the build tray, you can change their orientation manually, if
necessary —see “Model Orientation” on page 29.)

To change the default setting so that Automatic Orientation is disabled:
» In the Advanced section of the Options dialog box, clear the check box.

When Auto Zoom is selected in the Advanced section of the Options dialog
box, the display zooms in, to display the objects placed on the build tray.
This allows you to carefully inspect and manipulate the objects.

By default, this feature is not enabled. In any case, you can change the
zoom level, as necessary (see “Zoom Options” on page 46).

DRAFT DOC-06800 Rev. A
16 June 2013



Objet1000 - Connex 2 User Guide

Open GL The OpenGL driver displays 3D graphics on your screen. There is normally

Driver no reason to adjust its settings. If you suspect a problem with the way Objet

Configuration  Studio displays objects, you can use the OpenGL Driver Configuration tool
to check and configure the driver settings.

To access the OpenGL Driver Configuration dialog box:
1. From the Tools menu, select Options.
or—
In the Objet Studio Commands Menu, click Options.
2. Inthe Options dialog box, display the Troubleshooting tab.

Options 3
Appearance Grid | Manipuate | Disalay
Setinge | Advanced | Truhlesanating

OpentL Drwver Configuraticn...

[ Ok [ Cancel ]

Figure 5-94: Access to GL-driver configuration

The Troubleshooting tab is only accessible when Professional Mode is
active (see “Professional Mode Features” on page 65).

3. Click OpenGL Driver Configuration.
The dialog box that opens displays details of the pixel format ID (index)
for the window and the memory.
OpenGL Oriver Configuration E]

| wfindu Pissl Funnal | Memory Pisel Format | Advanced |

(O Pixel Fomat 1D |
(%) Chocse Fomat : Option 1 ~ .
ColorBits |24 :
DephBis [
Alpha Bis | o
ok || Ccancel |

Figure 5-95: OpenGL Driver Configuration dialog box

If you want to display the values and change them, click IZ' Alternately,
you can select Choose Format and change the values in this dialog box.
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To perform a test of the driver configuration and enter the suggested
pixel format ID:

1. Select Choose Format.
2. Click Test.

Objet Studio returns the recommended pixel format ID.

Objet Sludio ]

-
II') Choose Pieel Format: 5
\-\

Figure 5-96: Recommended pixel format ID

3. Click OK.

In the OpenGL Driver Configuration dialog box (figure 5-95), select
Pixel Format ID and enter this number.

5. Click Apply.
Display the other pixel format tab, and repeat this procedure.

5-68 DRAFT DOC-06800 Rev. A
16 June 2013



Objet1000 - Connex 2 User Guide

Getting Additional Objet Studio Assistance

Objet Studio Help provides on-screen instructions and information, as you
work.

To view Objet Studio Help:
» On the standard toolbar, click @ and then click Objet Studio Help.

Tools * Style @J:

Obje: Studio Help

_roubleskooting
Chiek Tur UpLales

@ abot...
Figure 5-97: Help options
You can also view information on the following subjects:

* Troubleshooting opens a list of error messages and their
explanations.

* Check for Updates checks if you are using the latest Objet Studio
version.

Objet Studio Version, Material Module and Licensed Features

You can view details of the Objet Studio version, the material module
installed, and the features available with your license.

To view details of your Objet Studio installation:

» On the standard toolbar, click & and then click About....

Tools + Style @J:
Ohje: Studio Help

_roubleskooting

Chiek, Tur UpLales

Figure 5-98: Displaying Objet Studio details

About Objet Studio  The About Objet Studio tab shows the Objet Studio version number and
tab basic information about your computer.

] 2]

Abaut Okjet Studio | | Matzrials Mcdule “eature License |

(IBJET

Chbizt Studio Ver. 9.2

Copyright ® 2012 Stratasys Lid.
All rights reserved.

For Applications Supoort: applications-inket @stratasys .com

Operating System:  Professional -Servics Pack 1 (Suild 7601+

Processor: Pentium [V«

Awvaiable Physical Mamory: 876 MB

System Resounces: T2%
0K

Figure 5-99: About Objet Studio tab
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Materials Module The Materials Module tab shows details of the material module installed.

5-70

tab o

2]

Module Date:

Figure 5-100: Materials Module tab

Module version: 3277

28.01.2013

Module Froperties: Default

*  Module version

If a Materials Module upgrade (patch) was installed, the new Materials
Module version is displayed. If no patches were installed, the Module
version is the same as the Objet Studio version.

*  Module date

If a Materials Module upgrade (patch) was installed, the date of its
creation is displayed. If no patches were installed, the Module date is the

date of the Objet Studio version.

* Module properties

If a Materials Module upgrade (patch) was installed, its description is
displayed. If no patches were installed, “Default” is displayed.
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Feature License The Feature License tab shows the Objet Studio features available with your
tab license.

Abeut Objct Siudio MabcrialeModuIc! eatire Iicemeg

el D00 Conngsd
= Modes
- High Qualiy
- High Speed
Digital b4 aterial
1 Maberials
1 Digkal materials,
1 Mied tray
True

o-E-B

Figure 5-101: Feature License tab

Click [# to expand the details for each feature.
* Modes shows the printing modes available.
See “Printing Modes” on page 48.
* Materials shows basic model materials available.
* Digital Materials shows the digital materials available.

* Mixed Tray shows if your license enables printing a build tray
containing objects, using a different model material for each.
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Monitoring and Managing Print Jobs

A

Job Manager

In the Job Manager screen of Objet Studio, you monitor and manage jobs
sent to the printer. There are a few differences between Objet Studio on
client workstations and on the computer connected directly to the 3D
printer —the server workstation.

* Objet Studio installed on a client computer only displays the queue and
status for jobs sent to the 3D printer server from that computer, and it
allows the user to edit only these jobs.

Note: If there are several Objet printers on the local network, client
computers can connect to any of them, but only one at a time.

* Objet Studio installed on the computer directly connected to a specific
3D printer (server), displays the queue and status for all jobs sent to that
3D printer by the server and by all client computers on the network. It
also allows editing and manipulation of all jobs, and enables re-sending
previously-printed jobs to the printer.

If Objet Studio is not connected to a printer (or printer server), you can
prepare tray files for any Objet printer. Later, these files can be used by
Objet Studio on the appropriate printer server.

The Job Manager screen on the client and server workstations looks

Screen identical. The only difference is that options only relevant to the server
workstation are disabled for client installations.
O E— o
Job Manager 8ot hiuidiae0ssse
Ribbon L8y
Jobs Queue_ "\.“f"'.'- - i Sy T, e ESm Y =i
Available
""" resources
Print Progress— S —
e8| 8
o 5 =] B | | Materials
Print History—{ | : il consumption
Waste status | ----- = ’
i | | Tray Preview
Figure 5-102: Job Manager screen
The Job Manager screen is divided into panels:
* Jobs Queue
* Printing Progress
* History
* Available Resources
* Material Consumption
* Tray Preview
* Waste
5-72 DRAFT DOC-06800 Rev. A
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Jobs Queue

Printing Progress
History
Available

Resources

Material
Consumption

Tray Preview

Waste
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On the server, the Jobs Queue lists the last 15 jobs sent from client
computers. On client workstations, the Jobs Queue lists jobs sent from that
computer to the printer server.

Information for each of the queued jobs is displayed, including the job
status.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Stopped Printing of this job was interrupted. Printing can later be

continued (Resume) or begun again (Restart).

Error Errors occurred during the printing of this job, and it was
placed in the Jobs Queue again.

Editing This job is now being edited in Objet Studio.

Spooling The job file is being spooled in the printer.

Preprocessing  The 3D printer is readying itself for printing: the cover
locks, print heads warm up and are put in starting
position, UV lamps are turned on, and the build tray level
is adjusted.

On Schedule The job is scheduled to be printed at a specified time.

In addition, the following information is displayed:
* Owner—the computer that sent the job.
* Build Time—the estimated building time for the job.

* Model Consumption—the amount of model material required to
complete the job, and the amount actually used till now.

* Support Consumption—the amount of support material required to
complete the job, and the amount actually used till now.

* Printing Mode—HS=High Speed, HQ=High Quality, DM=Digital
Material.

The Time panel shows printing times and the number of slices sent to the
printer.

The History panel shows information for the last 50 jobs and their final
status. You can drag a job from History to Jobs Queue to print the tray again.

The Awvailable Resources panel contains graphic indicators that show the
amount of available printing material remaining.

* Actual—the amount of material used till now
* Required—the amount of material still needed to finish the job

The Tray Preview panel displays the build tray view of the job selected in the
Job Queue or the History list.

On a server, you can open an enlarged preview window by clicking on the
Tray Preview display (see “Extended Tray Preview” on page 81).

If you move the mouse over the Waste display, the amount of waste in the
container is displayed.

DRAFT 5-73
16 June 2013



Using Objet Studio

Setting the When an Objet 3D printer is installed, the server computer is connected to
Printer that printer. Normally, there should be no reason to change this connection.
Connection Occasionally, however, you may need to reset the connection, to connect

the server to another printer, or to use Objet Studio in off-line mode
(without a printer connection).

To set (or change) the printer connection:
1. On the Job Manager ribbon, in the 3D Printer group, click cenm=e,
2. In the Set Printer dialog box, click Connect.

Figure 5-103: Connecting to a printer (A)

3. Enter the computer name or its IP address, or click Browse to find and
select it.

Figure 5-104: Connecting to a printer (B)

4. Click OK.

When the connection is established, Objet Studio is configured to
prepare print jobs for that printer.

Objet Studio is connected to the printer if you can see the material levels in
the Job Manager screen (see figure 5-102 on page 72).
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Off-line Mode  You can use Objet Studio to prepare trays for printing in off-line mode, on
a remote computer or when the printer connection is not available. You also
use off-line mode to prepare trays for printing with other printers. In this
case, if Objet Studio is currently connected to a printer, you must change to
off-line mode by removing this connection.

To disconnect Objet Studio from the printer: .

1. On the Job Manager ribbon, in the 3D Printer group, click cenm=e,

2. In the Set Printer dialog box, click Connect (see figure 5-103).
Figure 5-105: Disconnecting Objet Studio from a printer (A)

3. Inthe Printer Connection dialog box, delete the computer name/IP
address.
Figure 5-106: Disconnecting Objet Studio from a printer (B)

4. Click OK.
“Unknown” appears in the printer-name field.

5. Click OK.
In the pop-up message, confirm that you want to work in off-line mode
by clicking No.

B Job Manager

i Y ©Objet Studiois in off-line mode:.,

Do you Want to ccnnect to a 30 crinter?

Figure 5-107: Off-line message
When Objet Studio is in off-line mode, you can configure it for preparing
print jobs for different printers.

To change the Objet Studio off-line configuration:
1. Inthe Set Printer dialog box, select a printer type.

Set Printer

Printers:

Connex2E0 A

- Connex3E0
Connex5C0
Eden 260
Edon 350/
Eden 500 it Esrical
Objet1000
Objet24
Objet260
Objct20 <

Figure 5-108: Off-line printer selection

2. Click OK (not “Connect”).
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Setting the
Remote Printer
Connection
(Client Mode)

Job Manager
Commands
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When you open Objet Studio for the first time in a client installation, you
are prompted to connect to an Objet server computer that sends jobs to a 3D
printer. To do this, the server computer must be operating and connected to
the local network.

To set (or change) the connection to the server-computer:

1. On the Job Manager ribbon, in the 3D Printer group, click cict.

2. Enter the name of the server computer or its IP address, or click
Browse to find and select it.

3. Click OK.

Specty Server Computer named|P address.

Browse. .

W Uik aowert’ T ulf-lirie node,

Figure 5-109: Printer Server Connection dialog box

The Job Manager ribbon has three icon groups:

¢ 3D Printer

* Queue
* Job
. 3 al ¢ 4 20 & ¥EBL
Connzct Mobificatiors | Top Up Cown Bottom | Restart Stop Resume Delese Wew  Edit
30 Frinter Jueue Jok

Figure 5-110: Job Manager ribbon commands

Icons are enabled or disabled according to their relevancy. For example,
you cannot stop printing a job that is not being printed, so the Stop
command is disabled.
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The following operations are available on the Job Manager ribbon:

Purpose

Client: Sets the server connection. See “Setting the Remote
Printer Connection (Client Mode)” on page 76.

Server: Sets the printer connection. See “Setting the Printer
Connection” on page 74.

Configures options for printer alerts. See “Configuring User
Alerts” on page 79.

Group Icon
D
Printer Connect
hat
Mulificalive s
Queue Q
Top

Server: Moves a job to the head of the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 73.

3l

Up

Server: Moves a job to a higher position in the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 73.

Iﬂ

Bottom

Server: Moves a job to the bottom of the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 73.

7]

Dovan

Server: Moves a job to a lower position in the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 73.

Job &

Festart

Server:

* For ajob in the Jobs Queue—Prints it again (from the
beginning).

* For ajob in the History list—Moves it to the Jobs Queue
for printing.

Client: Disabled.

See “Restarting Jobs” on page 82.

Server: Stops a job in progress.
Client: Disabled.

ResLim e

Server: Continues printing the current job from the point
where printing stopped.

Client: Disabled.
See “Resuming Jobs” on page 82.

*

Removes the selected job from the queue.

Delete
<&  Refreshes the image of the selected job in the Tray Preview
= display.
Wiew
i # Opens the Tra¥1 Settings screen and displays the tray. For
5 deleted jobs, this enables you to make changes before
Edit printing.
DOC-06800 Rev. A DRAFT 5-77

16 June 2013



Using Objet Studio

In addition to using ribbon command icons, you can use commands on
context (pop-up) toolbars and from the Job menu on the standard toolbar.

Restart \
Stop n; 35-' E.— — L  Delete

” { =i -
Edit o %@-\—— Resume
Export Schedule
packed job

Figure 5-111: Icons on pop-up toolbar (server)

E ‘ Delete

.l.

Edit -

Figure 5-112: Icons on pop-up toolbar (client workstation)

Note: Most icons and menu commands are only enabled when a job is selected.

When you position the cursor over an item, a tooltip displays the name of
the command.

|;l:||:| 'iTDD|5 ~ Shyle

Y stop...

™

Delete 1ob...

Showa 3dProgress

& Export ...

Figure 5-113: Job menu options (server)
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Configuring
User Alerts
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Objet Studio can alert you (and others) to the status of jobs sent to the server
for printing. This is especially useful during long printing jobs, when the
operator is away from the printer. The following events can be reported:

* The level of model or support material is low.
* The job was interrupted.
* The job was completed successfully.

To send e-mail and SMS alerts, make sure that e-mail software supporting
MAPI is installed on the server computer. To send SMS alerts, the cellular
phone service must support the transmission of e-mail messages by SMS.
Only the subject line of the e-mail message is transmitted by SMS.

To configure Objet Studio to send notifications and alerts:
e
1. On the Job Manager ribbon, in the 3D Printer group, click Heficaticns

Notffications =

S il

<] e Messeges I " =esen

=

] T =it b Mislar

|HF Dreck ok 3502-8320,2362 Frote: .

| F2porl to earail

| ded3empien |
i L |

Fir A RAsinan

Celak...

FIFzpot v a5HS
| _Acd lezpril.

S 12 Forizkes [ 15an o] BofioCaiizpnsE oy

¥, ! Fohenotez [100g v BelasUabngesk po

[ ac ] [ zomeal

Figure 5-114: Notifications dialog box (server)

hatifieatin ns gl
[= So.nddle
g';" (S ak= Heisage: L peaker
=
[ lepsit i priks
| Rt o= e wal
e R
Fzmc-s Fcipizry
-
[ Repoit via ZHS
|| caw

Figure 5-115: Notifications dialog box (client workstation)

2. Set the desired reporting options.
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3. Click Details.

4.
5.

Select Events ba repart on:

i

Successhul jab firish
Job intermuption

End of Material reminder

[ Ok l ’ Cancel ]

Figure 5-116: Event selection for alerts

In the Reports Events dialog box, select the alert events and click OK.

In the Notifications dialog box, click OK.

If there is a job in the Jobs Queue, it is sent automatically to the Objet
printer —as long as it is on, there is a connection to the printer, and the
printer is on line. Chapter 6 describes starting and operating the printer.

Objet Studio on the printer server includes the following additional
features:

These features are described on the following pages.

Extended Tray Preview

Editing Jobs

Restarting Jobs

Resuming Jobs

Scheduling Jobs

Exporting Jobs (objzf)

Modifying the Job Manager Screen
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Extended Tray Preview

In this window, you can view the tray from different angles and
magnifications without leaving the Job Manager screen. In addition to
displaying the selected job in the Tray Preview pane, you can open an
enlarged build tray window.

To display the build tray window:
1. Select a job in the Jobs Queue or the History list.
2. Click the Tray Preview pane.

@ Tray Preview - crsatitf ol 5. ]

YHYIHAHOFED

Figure 5-117: Job Preview

* To change the tray magnification, turn the mouse wheel.

* Toview the tray from a different perspective, click the relevant icon.
* To resize the window, drag its edge or corners.

If there are several objects on the build tray, you can exclude one or more
from being printed, without actually deleting the object from the tray file.

To prevent the printing of an object on the build tray:
1. Double-click on the object you do not want to print.
2. Display the Build tab.

3. Select Exclude from Build.

2 0148:stl

Exclude from Buid

Objet Studio

! : dre you sure you want ko exclude this nodel from build process?

T

Figure 5-118: Excluding a model from the build

4. Click Yes to confirm.

On server computers, you can use Tray Preview to dynamically display
objects as they are printed, layer by layer. This enables you to visually
monitor printing progress on the computer screen.
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To display printing progress in the Tray Preview pane:
» From the Job menu, select Show 3dProgress.

%( This option uses additional system resources.

Editing Jobs

You can open jobs in the Jobs Queue for editing.
To edit a job:

1. Select the job. X

2. Click the Edit icon & .

The Tray Settings screen opens, displaying the build tray. The status of

the job in the Job Manager screen changes to “Editing.”
3. Edit the job. &

On the Tray Settings ribbon, click b marager -
The status of the job in the Job Manager screen changes back to
“Waiting.”

Restarting Jobs

You can restart jobs from the Jobs Queue and the History list.

To restart a job:

1. Select the job. &

2. Click the Restart icon sesat .

The job status changes to “Waiting” (in the Jobs Queue).

Resuming Jobs

If the printing process is stopped or interrupted, you may be able to
continue printing the job from the point where printing stopped.

To resume a job:
1. Select the job. B
2. Click the Resume icon resume .
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Scheduling Jobs

You can schedule jobs to be printed at a future time. For example, you can
configure Objet Studio to start long printing jobs in the late evening and
early morning hours.

To schedule a job:
1. Select ajob in the Jobs Queue, and click & on the pop-up toolbar.
2. Inthe Scheduler dialog box, set the Start Date and Start Time for the job.

Click on the Start Date arrow to open a calendar.

Iv Gtart Mrinting job in schedule:

Slart Dater | Sunday 170470 j
EB apilzono [N
Sun Mon Tue'wed "hu Fri Sat =
] 12 a3l
4 5 B 7 8 9 10
| 1z 13 14 15 16 17
19 19 20 21 2 23 M
252 272 oM oA J

Today: 4/11/2010

Figure 5-119: Scheduler with calendar displayed
3. Click OK.

Exporting Jobs (objzf)

You can save print jobs as compressed files.

For an explanation of objzffiles, see “Exporting and Importing Objet Build
Trays” on page 59.

To export a print job:

1. Select a job.

2. On the pop-up toolbar, click &

3. In the Save As dialog box, seh; a folder.
4. Click Save.

Moditying the Job Manager Screen

You can change the size of the sections of the Job Manager screen, by
dragging the panel edges. This applies to:

* the Jobs Queue panel
* the Time panel
* the History panel

Similarly, you can change the way the screen area is divided between the
main section (Jobs Queue/Time/History) and the panels on the right side of
the screen.

You can collapse (hide) the right panels (Available Resources/Material
Consumption/Tray View) by clicking the top of the panel.

* C(lick again to display the panel.
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Figure 6-1: The Objet1000 3D Printer

Starting the Objet1000 Printer

CAUTION!
* Do not attempt to operate the Objet printer before being trained by a

Stratasys customer-support representative.

* Observe all safety warnings and follow the safety guidelines described
in chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2: Main power switch

Turning on the printer also turns on the two built-in computers.
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Printer mode

Current activity

Waste
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(left/right)

Stop button
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2. After the printer-control computer boots, log in to Windows and
launch the printer-control program:

* On the printer-computer desktop, double-click the Objet printer
icon.

or—
* From the Start menu, select (All) Programs > Objet > Objet1000.

A HASP plug containing a valid product activation key is required on the
printer computer. This is installed at the factory or during printer upgrade. If
the application does not open and a HASP message appears, contact your
dealer or Stratasys Customer Support.

3. After the printer-server computer boots, launch the Objet Studio
program.

To switch the keyboard, mouse and monitor between the printer-control
computer and the printer-server computer, press Scroll Lock twice, then
press Enter.

The printer-control computer displays the main printer interface. All
monitoring and controlling of the printer is done from this interface.

K
¥ stratasys 07 dii AT

Y olllack Feraiind:

— e
i - M2 M-2R
L f X Ao | | 4nn g.:

_ \ Model material
y % ¢ e e cwhate > containers
! I [ (left/right)

| P_r:rs'r_lous]nb Ia;;t sll_ca; a i

Support material
L | _ containers
= (left/right)
Display

toggle button

Online/offline
button

Pause button

Figure 6-3: interface

One monitor displays both the computer running Objet Studio and the
printer server computer. Make sure that the printer interface is displayed.
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Loading Model and Support Cartridges

%

Objet1000 - Connex 2 printers use four containers of Model material and
two containers of Support material, each weighing 18 kilograms when full.
A graphical representation of the cartridges loaded and their current
weight appears in the printer interface (see figure 6-3).

The printer uses RFID technology to automatically identify cartridges of
printing material. For this purpose, an RFID module is part of the printer
hardware. Tampering with this module will render the printer inoperable and
may void Stratasys warranties and service contracts.

Important: If you need to replace the Model material currently
installed with another type, see “Changing the Model Material”
on page 6-11. Otherwise, make sure to replace the Model
cartridge with one containing the same type of material.

To load Model and Support material:

1. On the side of the printer, pull open the doors of the storage
compartment.

2. If you are replacing a material container, disconnect it from the feed
tube. Then, grasp the handle and pull the container out of the printer.

3. Load Model and Support containers into their respective
compartments.

4. Check the printer interface to make sure that the new cartridge is
detected and that its weight is displayed (see figure 6-3).

5. Close the storage-compartment door.

Tips about replacing cartridges:

* You can replace material cartridges either before or during printing.

* If printing stops for an extended time before you replace a material
cartridge, the printer may go into Standby or Idle mode. If this happens,
see “Resuming Production After Printing has Stopped” on page 9.

* You can replace partially used cartridges to avoid the need for replacing
them during printing.

* You can load partially used cartridges, as long as they contain more
than 100 grams of material.
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Producing Models

R

A
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The Objet1000 - Connex 2 printer produces models by printing tray files
prepared in the Objet Studio application and sent to the printer from there.
For information about preparing model files for printing, see “Using Objet
Studio” or Objet Studio Help.

Before beginning to produce models, it is recommended that you check the
current printing quality of the print heads by performing a pattern test (see
“Pattern Test” on page 23).

To prepare the printer for producing models:

1. Make sure that the build tray in the printer is empty and clean. If not,
remove cured material with the scraper, and clean the tray thoroughly
with a wet cleaning cloth.

CAUTION: Use protective gloves when cleaning the build tray, and be
careful of the sharp edges of the scraper blade.

2. Make sure that there is sufficient Model and Support material loaded,
as indicated in the printer interface (see figure 6-3). You may want to
replace the cartridges of Model and Support material currently loaded
in the printer to avoid the need for replacing them during printing.

For installing material cartridges and replacing empty ones, see
“Loading Model and Support Cartridges” on page 6-4.

For changing the type of Model material currently loaded, see
“Changing the Model Material” on page 11.

3. On the printer interface, click the red button to switch the printer to
online mode.

The color of the button changes from red to green (see figure 6-4). If
there is a job in the Job Manager queue, it is sent to the printer.

In the printer interface, the printer mode changes from Idle to Pre-print, as
the printer’s components prepare themselves for production:

* The print block is heated.
* The UV lamps are powered and they warm up.

When printing begins, Objet Studio sends seven slices to the printer. This is
the standard buffer between Objet Studio and the printer. As each slice is
printed, another slice is sent to the printer.

Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough Model
and Support material in the supply cartridges, printing proceeds
automatically until the job is finished.

During printing, the server computer must remain on and it must
communicate with the Objet printer. Do not log-off Windows until printing is
finished.
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Temperature
behind
print block

Temp. of each
Support head

Temperature.
in front of
print block

Chamber temp.

Evacuation

The Objet1000 - Connex 2 printer uses one or two Model-material
cartridges and one Support-material cartridge to produce models. If
additional cartridges are installed and they are not needed for the current
print job, the printer interface indicates which are being used:

* Blue cartridge—used for the print job
* Gray cartridge—not used for the print job

You can monitor printer status indicators by switching the printer interface
display. To do this, click the display toggle button in the printer interface
screen.

é\..T.-rSt"ata sys 1ndun A% 1964

Heads (2C) J

Temp. of each
Model head

Heade Liquld Support/Model
material in print-

block reservoir

~System

vacuum level

Temp. of material
pre-heaters

W Lamps Heads Yacuum

Evacuation

Fre Heater Front
Fra Haatar Rear

Display
toggle button

Printer set to
online mode
(green)

Figure 6-4: Printer indicators
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The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.

Green—suitable/ready for printing
For example, in figure 6-4:

O Heads Liquid—The level of Model and Support material in the print-
block reservoir is OK.

3 Vacuum—The vacuum level in the system is within the acceptable
range.

Red—not suitable for printing (or indicates a warning)
For example, in figure 6-4:

3 9000 Ambient—The ambient temperature of the printing chamber is
not within the acceptable range.

Blue—not ready
For example, in figure 6-4:
3 UV lamp—The UV lamps are not on.

O Heads (°C)—The heads have not reached the temperature required
for printing models (in printing mode).

The color of the material cartridges displayed in the printer interface
indicates which cartridges are active for the current (or next) print job.

Blue—active cartridges

Gray—reserve cartridges

DRAFT 6—7
16 June 2013



Operating & Maintaining the Objet1000 - Connex 2 3D Printer

Printing The printer interface screen changes when you send a print job from Objet
Indicators Studio to the printer, and the printer is on line (see figure 6-5):

* The mode changes from Pre-print to Printing.

* The specific activity being performed is shown in the “current activity”
field.

* Current job-printing information is displayed.
* The printing progress bar is displayed.
* The Stop and Pause buttons are enabled.

When the weight of a cartridge drops below 100 grams, the display of the
material level in the printer interface is red.

é":.’ Stratasys 07.Jun 7013 1652

Yorubluk

Printer mode
Job information Print Time 00:20:01 | Al g J
| Height 4.73mm of 28.37 mm J
Current Activity Brinang Dase e

M-1L
Job information <] Slice 163 of 1013 [15.15%] -
Previous Job last slize: 163 e

W le

Progress bar

Pause button

Figure 6-5: Printer interface during printing
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Resuming Production After Printing has Stopped

R

DOC-06800 Rev. A

If the printing process is interrupted, Objet Studio stops sending slices to
the printer. This can happen, for example, if the printing material runs out
in the middle of a print job, and you don't replace the empty cartridge
immediately. After the printer changes to Standby or Idle mode, you need to
resume printing from the Job Manager screen of Objet Studio.

After printing stops, the printer goes into Standby mode, when heating of
print heads is reduced. About 10 hours later, the printer goes into /dle mode,
when heating of print heads is stopped.

To continue printing the model:

1. If the printer is in offline mode, switch it to online mode by clicking the
red button at the bottom of the printer interface (see figure 6-3 on

page 3).
The button changes from red to green (see figure 6-4 on page 6).
2. If you don’t know why printing has stopped, make sure that the
connection between the printer and the server computer is active.
3. In the Job Manager screen of Objet Studio, click the Resume icon P@

In the Continue from Slice dialog box that appears, confirm the slice
number, after checking the printer interface.

Printer mode Standby 1

| Print Time 00:20:01

| Height 4.73mm of 29.37mm

Printing Pass 1

Last slice printed Slice 168 of 1013 (16.1%)

Figure 6-6: Printer interface after interrupted printing

Continue from Slice: i§|

163

0k | Cancel |

Figure 6-7: Continue from Slice confirmation in Objet Studio (Job Manager
screen)

5. If, for any reason, the correct number does not appear in the dialog
box, enter the number and click OK.
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You cannot continue printing the model if:

* The number of the last slice printed does not appear in the printer
interface, even if the server computer displays the Continue from Slice
confirmation dialog box.

* There was a relatively long interruption in printing, even if the “last
slice” and “continue from slice” indicators are correct. The part of the
model already printed may deform or shrink, and there might be a
visible difference between it and the newly printed part. The effects of a
printing stoppage on a model depend on the model size and structure,
Model material used, ambient temperature and the length of the

stoppage.
If you cannot continue printing:
1. Cancel the print job in the Job Manager screen.
2. Remove the partially printed model from the build tray.
3. Restart the job from the Job Manager screen (in Objet Studio).

You can stop and later resume printing from either the printer interface or
from the Job Manager screen of Objet Studio. After clicking the Stop button
on the printer interface, you can resume printing only from the Job Manager
screen. However, after clicking the Pause button in the printer interface, you
can only resume printing from the printer interface.
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Changing the Model Material

Before producing models using a different type of Model material than is
currently installed, run the Material Replacement Wizard to flush the print
block and feed tubes.

R

DOC-06800 Rev. A

You should carefully plan printing models with different Model materials to
avoid unnecessary waste of the materials currently loaded. The amount of
material flushed depends on the flushing cycle chosen and if you are
replacing one or both Model cartridges.

To replace the Model material:
1. Start the Material Replacement Wizard from the Options menu.

st

Cakn ol ppes mahon
ot el on P

" ! IEdun 2B1Y 9]
e ;
el e Ingecton
Cabn e s =ghon

wernkinrk ¥renklrl

g e e

| Paem Tec:

(TR EP O

MErbeneras Counars.
Skl Sevio Daa

OBJET 1000

Figure 6-8: Starting the Material Replacement Wizard

In the opening screen, click Next

3. If the printer cover is not closed, a screen appears, prompting you to
close the cover. Confirm that it is closed and click Next.
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4.

If the printer doors are not closed, a screen appears, prompting you to
close them. Confirm this and click Next.

Material Raplacemant Wizard

Material Replacement Options
Printing mode

) Single material printing meds (4, HS)
O MAultiple raterial: pricting rmode (D)

Required materials

FMote: Caticge positioning in raterial cabinetis detenmined avtomatica ly.
| VeraWwhite R
[ Bath catridgss

Flushing cycle
& Full

'C'Economy

'Full' pravides vau with exact colorimmedialely.
‘Ezonomy’ enables z tast=r matenal replacement cvce.

[ 7 Help | ’Advanced Sattings...] [ X Cancel l < M g

Figure 6-9: Material Replacement options

In the Material Replacement Options screen, you select the settings that
determine how the wizard replaces material currently in the system
with newly loaded material.

Choose whether you want to produce models in Single Material mode
or in Digital Material (“multiple-materials”) mode.

Single Material mode
Four print heads are used to print, using one Model material.

3 This mode is required to produce build trays with the High Quality
setting, and to produce trays with the High Speed setting, using only
one Model material.

Digital Material mode
Each of the Model materials loaded is used in two of the print heads.

3 If only one of the Model materials is required for printing, models

are produced using two print heads. This makes it unnecessary to
replace the other Model material.

O If Model-material substitution is allowed, the printer produces trays
with the High Speed setting using a mixture of Model materials (see
“Model Material Substitution” on page 5-52).

In the Required materials section of the wizard screen, select one or more
replacement materials.

Select Both cartridges if you need to load two replacement cartridges.

Loading one replacement cartridge is more economical because it
potentially requires less flushing of material currently in the system.
However, when one cartridge is not sufficient, loading two cartridges
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enables continuous printing until the print job is completed. When one
cartridge empties and the second cartridge is being used, you can
replace the empty cartridge with a new one.

8. In the Flushing cycle section of the wizard screen, choose how
thoroughly you want to flush out material currently in the system.

*  Economy. This cycle can be used when replacing a light-colored
Model material with a darker material (such as TangoBlack™ or
VeroBlack™), or if the exact color of the printed models is
unimportant.

The wizard flushes the system with the minimum amount of
material needed to ensure that models have the mechanical
properties of the new material.

* . Use this cycle when the printed models must have the exact color of
the new material.

The wizard thoroughly flushes the feed tubes and print heads
needed for printing, based on your selections in the previous
screens.

9. C(lick Next to begin the material replacement process in the printer.

There are additional settings that you can select for special purposes (see
%( Advanced Settings.) If necessary, click Advanced Settings before clicking
Next.
The Cartridge positioning screen appears, showing you the new location
of all cartridges in the materials cabinet.

Material Replacement: Wizard
e Cartridge positioning and process progression
Vd \\ Insart the new material carricge 25 shown below, and dick Start
[ &E.
| .
\ Qﬁ /'f Left Right
| M2 VeroBlack v VeroBlack v
b1 VeroWhite o VeroWhite N
s SR — FullCure705 L7
Start.,
Replacement progress
of 0% |
= | Stratasys A e e e e
X Lancel | 1(Ere\vi:|us] e 3 |

Figure 6-10: Cartridge placement

Symbols:

w Correct container is in this position.

£3 No container or incorrect container is in this position.

44 Container in this position has insufficient weight to complete the
material replacement process.

10. Replace material cartridges, as necessary, according to the instructions
in the wizard screen.

11. Click Start.
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12. Read the warning message, and click OK.

before you can produce models. To replace material cartridges at another
time, click Cancel. If you continue (by clicking OK) and you do not complete
the process, you will need to run the wizard again before producing models.

Q If you continue, you must complete the material replacement process

Material Replacement Wizard

P — Material replacement completed
n’ \\. i~ Printer's curreat configuratiory
4

!i I‘ Qﬁ ' Left Right

e M2 VeroBlack VeroBlack
11 VeroWhite VeroWhite
Suapart FullCure705 FullCure705

Printing mode: Digital materials (DM)

~'Stratasys

Important: After closing this wizard, deanthe area around the purge unit.

?@ Lancel | 2 Brevious | " Dione I

Figure 6-11: Final wizard screen

13. Click Done to close the wizard.

The printer-control application is automatically updated, and the
interface displays the new material(s). The Objet Studio application (on
the printer-server computer) is also updated and displays the new
material(s).

14. Inspect the area around the purge unit and clean it, if necessary.

CAUTION: Dispose of all material containers in accordance with all
applicable laws and regulations.

Advanced The Advanced Settings dialog box enables you to configure the Material
Settings Replacement Wizard for special purposes. If necessary, click Advanced
Settings in the Material Replacement Options screen before clicking Next.

Material Replacement Wizard
y i N Advanced Settings

| Q | Cariridge positioning:
J ¥ Automatic slot szlecton (Recommended)

7 Manual slul selection

Thiz selection applies ta this use of the wizard only.

:"Ir Stmtasys " "Flishagain® aptinns

& Help i Cancal | =

Figure 6-12: Advanced Replacement settings
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Cartridge By default, Automatic slot selection determines the best positioning for the

positioning

Flush Again

DOC-06800 Rev. A

material containers, based on materials currently in the system. This
ensures minimum flushing of materials currently loaded. If there is a
special need to load material containers in certain docks in the printer,
select Manual slot selection.

After clicking Apply, the Material Replacement Options screen appears, but
now, each material selection box corresponds to one of the container
positions in the printer.

MiL ME MZL MZ2R ‘

Required mater.alsx T Indicates Manual

S Marts / Placement Mode
[Verowaits ~| | [veroBleu - ;‘1\
[ Bulh carridyes Bol't cerl idyes w

. .

|

Figure 6-13: Manual container positioning

The flushing cycle you select in the Material Replacement Options screen
determines how thoroughly to flush out material currently in the system.
After selecting the Economy cycle and completing the wizard, you may
decide that you require a more thorough flushing, to ensure accurate
model color. Or, you may notice that printed models are not satisfactory
because they contain traces of the previous material. If so, you can flush out
more material, so that the next models will be printed with pure material.

After selecting the “flush again” option and clicking Apply, the Material
Replacement Options screen appears, where you select the affected
material(s) to be flushed.

Note: Select only the materials you need to flush.
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Keeping the Printer in Idle Mode

R

Between printing jobs, the Objet1000 - Connex 2 printer can be kept on for
up to one week. If the printer will not be used for more than a week, use the
Shutdown Wizard to automatically perform the procedures that must be
done before turning off the printer (see “Shutting Down the Printer,”
below).

When the printer stops producing models, the printer software
automatically reduces the temperature of the print heads as follows:

Time after printing Mode Change in heating of print heads
first 15 minutes Standby 1 none

next 10 hours Standby 2 heating reduced (to room temp.)
after 10 hours Idle heating stopped

Note: The printer mode is indicated in the green field on the left of the
interface (see figures 6-3, 6-4 and 6-5 on pages 3, 6 and 8).

If, after printing a job, you know that the printer will not be used for 10
hours or more, you can immediately turn off the heating of the print heads
by putting the printer into Idle mode.

To put the printer into /dle mode:
» From the File menu (in the printer interface) click Exit.

Note: The printer remains in /dle mode until you open the Objet printer
application and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this
mode—with the cover closed—for up to a week. For longer periods, shut
down the printer by running the Shutdown Wizard (see below).
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Shutting Down the Printer

You only need to shut down the Objet printer if it will not be used for a
week or more. Otherwise, the printer can remain on, in Idle mode.

To avoid flushing out valuable material, make sure to print models at least
once a week. Many printer operators use this opportunity to print customer
samples or test models.

g The Shutdown process flushes printing materials from printer components.

To properly shut down, the printer needs to perform several processes.
These are controlled by the Shutdown Wizard. Do not attempt to shut
down the printer by simply closing the computer interface (the printer-
control application), and never disconnect power to the printer before
completing this wizard.

Depending on the length of time the printer will not be used, you can
choose between a short shutdown procedure, and a more thorough
procedure.

* Up to 10 days: The wizard empties the print block of Model and
Support material, to prevent leaks. This takes about 10 minutes.

* More than 10 days: The wizard empties the print block, then flushes
the system with cleaning fluid. This takes up to 35 minutes, and you
must be present to load cleaning-fluid cartridges when instructed.

To run the Shutdown Wizard:
1. Start the Shutdown Wizard from the Options menu.

Shutdown Wizard

Shutdown Wizard

¢ This wizard controls the processes tecessarw for shutting
dowr the printar.

Press 'Mext! to continue or 'Conzel' 1o guit.

< Stratasys
< Help X Cancel | -Eeviou;l PN
Figure 6-14: Shutdown Wizard, opening screen
Click Next.

3. Choose the appropriate option for the length of time that the printer
will not be used —less or more than ten days.

Note: Before selecting More than 10 days, make sure that cleaning-fluid
cartridges are available.

4. Inthe next screen, verify that the tray is empty and click Next.
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The shutdown procedure begins.

Shutdown Wizard

Shutdown in Progress

00:02

</ stratasys

<5 Pravious | Mew o> |

Figure 6-15: Shutdown progress screen

5. When the final wizard screen appears, close all open programs on both
computers, and shut down the computers.

Shutdown Wizard

N Shutdown Wizard completed

“ou ey niow shut down the printer computer anc turn off
poweer to the printer,

-V stratasys

G Cancel | Er:viouzl w* Done I

Figure 6-16: Final Shutdown Wizard screen

6. After both printer computers shut down, turn off the main power
switch at the back of the printer (see figure 6-2 on page 2).
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Maintaining the Printer

The performance of routine maintenance tasks is essential for getting
satisfactory results from Objet 3D printers. Perform the tasks at specified
intervals for optimum performance.

Routine
Maintenance
Schedule

DOC-06800 Rev. A

message appears.)

Frequency Task For More Information
Daily / before printing | Clean the print heads See “Cleaning the Print
and the roller surface. Heads” on page 6-20.
Weekly Clean the build tray and
the surrounding area.
Weekly Perform the Pattern test. | See “Pattern Test” on
page 6-23.
Weekly Clean and inspect the See “Cleaning and
wiper. Replacing the Wiper”
on page 6-24.
Weekly —when printing | Calibrate the UV See the instructions in
with MED610 intensity. the UV-meter Kkit.
Weekly Restart the printer
computer and the
server computer.
Weekly Clean the roller waste | See “Cleaning the Roller
collector. Waste Collector and
Inspecting the Roller
Scraper” on page 6-27.
Every 300 hours of Calibrate the UV
printing (A reminder intensity.

Every 300 hours of Replace the roller pump
printing tubes.

Every 300 hours of Lubricate the X-axis.
printing

Monthly, and after
replacing print heads

Check the alignment of
the print heads.

See “Aligning the Print
Heads” on page 6-32.

printing, or once a year

visit by authorized
service engineer.

Monthly Inspect the exhaust
system (duct, fan,
connections).
Monthly Calibrate the load cells. | See “Calibrating the
Load Cells” on
page 6-40.
Every 2000 hours of Preventive maintenance | Contact your Stratasys

support center.

DRAFT
16 June 2013



Operating & Maintaining the Objet1000 - Connex 2 3D Printer

Cleaning the Periodic inspection and cleaning of the orifice plates on the bottom of the
Print Heads print block ensures that the print nozzles are not clogged. A wizard guides
you through the procedure, and adjusts components of the printer to
enable you to perform it. This procedure takes about 20 minutes, and
should be done at the beginning of the work day or before a big printing
job.
To clean the print heads:
1. Prepare—
* isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
* disposable cleaning gloves
* the supplied cleaning cloth or equivalent
* amirror

2. Start the Head Cleaning Wizard from the Options menu (see
figure 6-24 on page 25).

3. Follow the instructions on the wizard screens, and select the
confirmation check boxes.

Head Cleaning Wizard

Head Cleaning Wizard

Flegse check ifthe trey is nseted and ampty, aad
rlns= the dnnr

v Trayiz insened
¥ Trayis erpty

[+ Dioois are cloged.

' Stratasys

X Cancel | z ‘Elaviou;l Mt o I

Figure 6-17: Head cleaning procedure—wizard screen
4. Click Next.

The printer prepares for you to clean the print heads.
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5. When the following screen appears, open the cover.

Head Cleaning Wizard

Are heads clean ?
A

f— l t Plezse cpenthe dootand clean heads.
s [ Heads clean

</ Stratasys

X Cancel | 5 Pravious | Hew ==

Figure 6-18: Head cleaning wizard—steps 5-10

. WARNING: The print head orifice plates (bottom surface) may be hot.
: Do not touch them with your bare hands, and proceed with caution.

6. Place the mirror on the build tray.
7. Put on the gloves.
8. Soak the cleaning cloth with alcohol.
9. Clean the orifice plates, with a back-and-forth motion (see figure 6-19).
Use the mirror to make sure that you have removed all of the residue
material.
DOC-06800 Rev. A DRAFT 6-21
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Figure 6-19: Cleaning the heads

Use this opportunity to clean the entire roller surface, by rotating the roller,
and clean the UV lamps.

10. When you have finished cleaning, select the confirmation check box in
the wizard screen (see figure 6-18) and click Next.

11. Remove the cleaning materials from the printer and close the cover.

12. Select the confirmation check boxes in the wizard screen and click
Next.

The head-purge cycle begins. When this is complete, the final wizard
screen appears.

Head Cleaning Wizard I

Head Cleaning wizard completed

I stratasys

2\’5’ Latice] | «.E Eraviou;l \/Qone I

Figure 6-20: Head-cleaning wizard—final screen

13. Click Done to close the wizard.
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Pattern Test
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The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the
print heads. Make sure, therefore, that you perform this test weekly, and
whenever you suspect a printing problem.

To perform the pattern test:

1. Make sure that the build tray is empty.

2. Prepare a sheet of pink paper —A-4 or Letter size.

3. In the printer, tape the pink paper to the surface left of the build tray.
4

Press F3, or open the Options menu and select Pattern Test.

€ ) Perform Pattern Test?

Figure 6-21: Pattern Test confirmation

5. If the build tray is not clear, click No in the following dialog box.
This lowers the build tray, so that models on the tray are not damaged.

9 1s the builc tray dear?
- _—J/ {If wou dick 'NO', the tray will bz lowsred.)

Figure 6-22: Build tray (Z) level adjustment

The printer prints a series of lines on the test paper (see next figure).

Figure 6-23: Sample Pattern Test

6. Carefully inspect the test paper to see if there are missing lines.

Too many missing lines, especially if they are in the same area,
indicates that the quality of printing when producing models will be
poor. If this is the case, see “Improving Print Quality,” below.

Note: Acceptable model quality is subjective, and depends on the type
and scale (size) of the models produced. As a rule, however, more than 10
missing lines in one area of a column is considered unacceptable.
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Improving If you suspect that print quality is poor, perform the pattern test (see
Print Quality “Pattern Test” on page 6-23). If the results are poor, use the following
procedure to improve print quality.

If the results of the last pattern test are poor:
1. From the Options menu, select Purge Sequence, or press F4.
2. In the confirmation dialog box, click Yes.

The print heads are purged of Model and Support material, and the
wiper removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see “Cleaning the Print Heads” on
page 6-20).

2. Perform the purge sequence.

3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue
left on them.

2. Perform the purge sequence.

3. Perform the pattern test.

If the results of the pattern test are still poor:
» Consult with your Stratasys service provider about replacing faulty
print heads.

Cleaning and A rubber wiper removes excess material from the print heads after the

Replacing the  purge sequence. This is done automatically before each print job, and

Wiper performed manually during maintenance tasks. You should clean the
wiper and surrounding area at least once a week. If the wiper is damaged
or worn, replace it.

To inspect and clean the wiper:

1. Prepare—
* isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
* disposable cleaning gloves
* the supplied cleaning cloth or equivalent

* aspare wiper
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2. Start the Wiper Cleaning Wizard from the Options menu.

05 Mey 2001 17:09

Poogetequence

Fatem teab

Hobin rats

LR T L

Figure 6-24: Starting the Wiper Cleaning Wizard
3. Intheopening wizard screen, click Next.

Make sure that the build tray is empty, and close the printer doors.

Confirm this in the wizard screen and click Next.
el Inspect the build tray

Coniirm hefare continuing:

¥ Builc tray & clear(empty) and the doois are closed.

i i | i ] ),

-:‘-,_'-:’Stratasys

x Lancel | {i Erzvious | Mot )- I

Figure 6-25: Wiper Cleaning procedure—step 4
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5. When the following screen appears, —open the printer doors.

Inspect the wiper

Coniirm hefore continuing:

[ The wiper blade is clzan.

(BEEBEE8EE)

-/ Stratasys

X Cancel | b Ereviou;l Mest I

Figure 6-26: Wiper Cleaning Wizard during steps 6-9

6. Put on the cleaning gloves.

7. Using a generous amount of alcohol on the cleaning cloth, remove any
material remaining on the wiper and the surrounding area.

8. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.

a. Grasp it and pull it up and out of its bracket.

b. Insert the new wiper blade, making sure that it is straight and secured
well on both sides.

9. In the wizard screen (see figure 6-26), confirm that the wiper blade is
clean, and click Next.

10. Remove all tools and cleaning materials from the printer, and close the
doors.

11. Confirm this in the wizard screen, and click Next.
' Inspect the build tray

Coniirm hefore continuing:

v Builc trap = clearfempty] and the doms are closed.
([BB8888EE6)
</ Stratasys
x Lancel | Brovious Mo g I
Figure 6-27: Confirmation screen
12. Click Done to close the wizard.
DRAFT DOC-06800 Rev. A
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Cleaning the The roller waste collector removes waste material scraped from the roller.
Roller Waste Suction removes this waste to the printer’s waste container.

Collector and
Inspecting the
Roller Scraper

This assembly should be cleaned weekly to prevent a blockage in the tubes
leading to the waste container, so that waste material does not overflow
into the printer.

To clean the roller waste collector:
1. Prepare—
* M2.5 and M2 Allen keys
* disposable cleaning gloves
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
* cleaning cloth
* cotton swabs (Q-tips® or similar)
2. Puton the gloves.
3. Remove the right UV-lamp assembly:
a. Disconnect the UV power cable and the fan power cable.

Fan power
~connector

-Power connector

Figure 6-28: Disconnecting the right UV assembly
b. Remove the screw attaching the right UV lamp to the print block,
and then pull and lift up the UV lamp.
4. Loosen the two screws securing the suction tube on the print block.

Figure 6-29: Lifting the suction tube
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5.
6.

Lift the suction tube to secure it in a raised position.

Remove the two screws securing the covering of the roller waste
collector and remove it.

Be very careful to save the covering screws. These are special screws; if
they are lost you need to order replacements.

Roller waste
collector screws

Figure 6-30: Removing the roller waste collector covering

Remove the covering by pulling it out, and then lower it.

Clean the roller waste collector and the scraper blade surface using
cotton swabs. Make sure to remove any remaining printing materials.

Figure 6-31: Cleaning the roller waste collector

scraper—see below.

% Before replacing the covering you can check the effectiveness of the roller

To check the effectiveness of the roller scraper:

LN

Put on the cleaning gloves.
Wet a cloth with isopropanol.
Use the cloth to wet the bottom of the roller.

Turn the roller slowly with your hand. As the blade scrapes the roller,
make sure the isopropanol is spread evenly over the entire length of
the blade.

Inspect the roller. If it is not dry, replace the blade. (See “Replacing the
Roller Scraper” on page 6-29.)
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Replacing the
Roller Scraper

=
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6. Before returning the roller waste collector to the print block, make sure
that the pins are clean.

Roller waste
collector pins

Figure 6-32: Roller waste collector pins

7. Return the roller waste collector to the print block and screw on the
covering (see figure 6-30 on page 6-28).

8. Loosen the screws securing the suction tube.

: = Securing screws

Figure 6-33: Suction tube correctly positioned

9. Lower it so that the hole in the panel behind the suction tube is visible,
and tighten the screws to secure the tube.

10. Attach the right-UV-lamp assembly to the print block and reconnect
the UV power and fan cables.

You should replace the roller scraper blade:

* after 1,000 hours of printing.

* if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you
clean the roller waste collector. See “Cleaning the Roller Waste Collector
and Inspecting the Roller Scraper” on page 27..

To replace the roller scraper:

1. Prepare—
* anew roller scraper (knife) (KIT-01026-S)
* a Phillips 1x75 mm screwdriver
* M2.5 and M2 Allen keys

2. Remove the right UV lamp and the roller waste collector covering (see
steps 3 to 6 on page 6-27.)
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3. Loosen the two screws securing the roller waste collector and pull it
out.

Figure 6-34: Removing the roller waste collector

4. Remove the screws that secure the roller scraper assembly.

Figure 6-35: Removing the roller scraper screws

il
o 1

= s o

Figure 6-36: Removing the old roller scraper blade

5. Remove the scraper blade and discard it.
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6. Place the new scraper blade onto the pins in the holder, as shown.

P

-

o
O?/ 2

Figure 6-37: Inserting the new roller scraper blade

7. Insert and tighten the roller scraper blade screws.

Important:
* Tighten the screws in the order shown in figure 6-38.
* Use the new screws supplied in the replacement kit.

Figure 6-38: Tightening the roller scraper screws

8. After tightening the screws, inspect the blade and make sure that it is
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to
the print block. See steps 6 to 10, from page 6-29.
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Aligning the
Print Heads

6-32

You should check the alignment of the print heads—
* once a month
* after replacing one or more heads

* if model quality is not acceptable even after cleaning the orifice plate on
the bottom of the print block (see “Cleaning the Print Heads” on
page 6-20)

The head-alignment procedure takes about 20 minutes.
To check the alignment of the print heads:
1. Prepare—

* atransparency sheet—A-4 or Letter size

* any type of sticky tape, to fasten the transparency sheet to the build
tray

2. Start the Head Alignment Wizard from the Options menu (see
figure 6-24 on page 25).

3. Click Next to begin, and close the cover.

In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.

5. When instructed to do so, place the transparency on the build tray —
next to the left and rear edges of the tray, as shown in the following
figure.

— = - — - -

Figure 6-39: Positioning the transparency on the build tray

6. Make sure that the transparency sheet is lying flat, and tape it to the
tray.

7. In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.

The printer prints the head alignment test on the transparency.
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8.  When the following screen appears, remove the transparency.

Head Alignment Wizard

Head Alignment Wizard

aa: Removetransparency from tray.

[~ Trareparency remavad,

'/ Stratasys

X Cancel | Ereviou;l Mest I

Figure 6-40: Head Alignment Wizard—steps 8-10

The transparency sheet is printed with sets of vertical lines in seven
columns, each showing the results from a different print head.

Print Head Numbers
0 1 2 3 il 5 6

|||I|II|||| |||||||”||| Yl |||||H|I|I |I|III llll IHIIHIIII I|||I|I||||I

|'|'|i'||'| |'|'””|'| I|'||H|'|I |||||H|I|I TR |”H||I|I| I|||I|I||||I

Figure 6-41: Sample head-alignment test

* The three columns on the right were printed by the heads used for
applying Model material when producing models. From right to
left, the columns represent heads M1, M2, M3, respectively. (There
is no column for head MO because its alignment is used as a
reference for aligning all other heads.)

* The four columns of lines on the left were printed by the heads used
for applying Support material. The columns represent heads S3, S2,
S1 and SO, respectively.
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9.

10.

11.

For each column of lines, use a magnifying glass or loupe to inspect
pairs of consecutive rows printed on the transparency to see where the
vertical lines align.

Alignment-line
123 4' 3 6 ¥ numbering, left-to-right

\h‘a J’If‘
ARRENY

LT
ARRNEN

Figure 6-42: Comparing rows of alignment lines

Row pair:

Note: It does not matter which pair of lines you inspect, since they were all
printed by the same head. Choose a pair of clearly printed lines for the
inspection. (Since some nozzles may not print clearly, you may have to
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper
and lower rows are aligned, as in figure 6-42. In the example shown, no
change to the head alignment is necessary. If other lines in the set are
aligned, you need to change the alignment of that head —in the next
wizard screens.

In the wizard screen shown in figure 6-40, select the Transparency
removed check box, and click Next.

The first in a series of alignment screens appears.

= Head 6

OFF
OFF Selectthe number represanting the aligned lines
0 on te fransparency.

OFF

I
OFF 1 2 3 4 5 5 7

- Stratasys

¥ Help X Cancel | ~(Ereviou:l

Figure 6-43: Head alignment screen

In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows of a pair on the transparency
(counting from the left) for this print head.

Note: Because the alignment of the fourth lines is optimum, the number “4
is selected, by default, in the wizard screen. This does not change the head
alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.
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12. Click Next to display the next head alignment screen, and again select
the number representing the most closely aligned vertical lines on the
transparency for that print head.

When you have finished aligning all of the heads, the following screen
is displayed.

Update System Parameters
Do you want o ugdate the aligiment perameters?
" da
& Yeg
<" Stratasys
2 Help X Cancel | ~& Pravious | Mest o I

Figure 6-44: Update confirmation screen

13. Continue as follows:

* To make the alignment changes in the printer, make sure that Yes is
selected, and click Next.

* To recheck the alignment test results before making the alignment
changes in the printer, click Previous.

* If you do not want to make alignment changes in the printer at this
time, select No and click Next.

14. In the final wizard screen, choose to either repeat the head alignment
procedure or close the wizard.

* If the most closely aligned vertical lines for a print head were at
either extreme —the first or seventh lines—choose Yes to run the
Head Alignment Wizard again, then click Next.

The transparency test will show if the heads are now properly
aligned, and —if not—the wizard will allow you to “fine tune” the
alignment.

* If the vertical lines for the print heads were not aligned at either
extreme, choose No to close the wizard, then click Next.

Head Alignment Wizard

Do you want to rcpeat the test?

% o, | wantto end the wizard

" Yes, | warl to prnt another transaarency

</ stratasys

& Help x Cancel | ~(Ereviou;l Mest I

Figure 6-45: Final Head Alignment Wizard screen
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Replacing
Print Heads

R

Testing and
Calibrating the
UV Lamps

6-36

The condition of the print heads directly affects the quality of printed
models. You may need to replace a print head if one or more of the
following symptoms occurs:

* There are noticeable grooves in the surface of printed models.

* Visual inspection of the head reveals that its surface is damaged —
peeling or bubbles in the nozzle area.

* The printer interface displays a warning or malfunction message
relating to a print head —

O Head Heater temperature timeout
O Head Heater thermistor open
O Head Heater thermistor short

Replace print heads only after consulting with an authorized customer-
support engineer.

The effective UV radiation from the lamps used for curing models can
change over time. To ensure optimum curing of models during printing, a
pop-up message reminds you to test the lamps and calibrate their effective
UV radiation after every 300 hours of printing. You do this by running the
UV Calibration Wizard with an external UV radiation meter.

The wizard compares the radiation you measure to the recommended
radiation level for each of the lamps, at each printing mode —High Speed,
High Quality and Digital Material.

When calibrating the lamps, the wizard attempts to adjust the radiation
level, if necessary, and then prompts you to take a new reading.

* If the reading is within the acceptable range, the wizard continues to
the next phase.

* If further adjustment is necessary, the current phase is repeated.

* If the UV radiation is too low to be properly adjusted, the wizard
continues to the next phase, but the final wizard screen indicates that
the lamp’s radiation for the printing mode is unacceptable.

Before testing and calibrating the UV lamps:

* Make sure the glass lens on the UV lamp is clean. For easy access, run
the Head Cleaning Wizard, and use the special cleaning pad supplied.

* Make sure that the UV radiation sensor is available to you, and that its
protective glass is clean.
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To test and calibrate UV lamp radiation:

1.

3.

Start the UV Calibration Wizard from the Options menu (see figure 6-24

on page 6-25).

If the following screen appears, select UV Power Calibration to adjust

the power supplied to the UV lamps so that the UV radiation is within
the acceptable range.

</ stratasys

2 Help

Choose Wizard mode

@ 1 Prweer Calibratinn

1 1 Prwer " eat

X Cancel iz Mest =

Figure 6-46: UV Test/Calibration selection

Make sure that the build tray is clear (empty), and close the printer
cover. Confirm this in the wizard screen and click Next.

/Qh . Y
f { \".
Red
\ F

-V stratasys

Prepare the printer

Coniirm hefore continuing:

[ ] The build Iray is clear [empty).

[ |Door: are cloged.

Figure 6-47: Printer preparation

DRAFT 6-37
16 June 2013



Operating & Maintaining the Objet1000 - Connex 2 3D Printer

6-38

4.

8.
9.

When the following screen appears, open the printer and place the UV
sensor at the rear edge of the tray, in the center.

Place the sensor

Cenfirm before confinuing:

[ The senson iz in the cenler ol he bap's ‘o euge

' stratasys

Figure 6-48: Place the sensor screen

f
Figure 6-49: Correct UV-sensor placement
Make sure that the sensor cable is securely connected to the sensor.

Lead the cable out of the printer so that you can close the printer, and
make sure that the cable will not interfere with the moving print block.

Close the printer, while checking that the sensor does not move out of
position.

Set the UV meter to measure mJ/cm?2.

Set the range on the meter to 2,000.

10. Connect the cable from the sensor to the UV meter.

11. Turn on the UV meter, and wait until “0 0 0.0” appears on the display.
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12. In the wizard screen, confirm that the sensor is positioned correctly,
and click Next.

When flou click Next, the UV lamgs power up and stabilize. (This takes
several minutes.) Then, the print block passes over the sensor and

UV Intensity Measurement

;. aﬁ ] Currently izading  Right UV lamp in Digital Materials Mode
\ .).‘

Lamp stabilization

Measure UY progress
. (A5 Cycles)

Ouerall prograss

< stratasys

x Lancel <% Previous MHes

Figure 6-50: UV measurement progress

13. When prompted by the wizard, zero (reset) the UV meter and enter the
reading (measurement).

If the UV level measured is not acceptable, the wizard calibrates the UV
lamp by adjusting the current supplied to it, and then tests it again.

When all UV tests have finished, the results are displayed, showing the
condition of the lamps after calibration.

UV Calibration Results
| 1eft UV | Aamp Ringht LIV | amp
(8] ¥ ] : o 1801 % [100%] | 3¢ 33xp0cy
Calibiate lamp
HO T o 1521 % [100%] ' «F 1767 5 [100%]

HS | o 1%3x[110%] | $2 49%0130%)
Calib-ate lamp

</ Stratasys

Figure 6-51: Results and condition of UV lamps after calibration
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After examining the UV calibration results:
1. Click Next.

UV Testing/Calibration Complete

' stratasys

Figure 6-52: Final UV Calibration Wizard screen

Calibrating the Load cells are sensors that measure the weight of the printing cartridges

Load Cells and the waste container in the printer. It is important that you periodically
check that the weight measurements are accurate, both for convenience and
to prevent unnecessary waste of printing materials. It is recommended that
you calibrate the load cells once a month.

To calibrate load cells:

1. Start the Load Cell Calibration Wizard from the Options menu (see
figure 6-24 on page 25).

2. Make sure that there are no containers on the load cells that you want
to calibrate, select the appropriate check boxes in the wizard screen,

and click Next.
Select the load cells to calibrate

Qﬁ Remove each cartiidge vou select=d and close the panels,
[T ruded - 2 Ler. [CIruud - 2 Right
[ roded - 1 Ler [CIroddd -1 Rl
[ suppuit Ler. [CJ5uppurt Righit
[ wraste Left [Clwwast= Riuht

<" stratasys

Figure 6-53: Load cell selection
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3. confirm this in the wizard screen, In the next wizard screen, observe

the numbers and wait until the level is relatively stable —two units

above or below the average level shown.

Load Cell Calibration Wizard

2 Values of selected load Cells

.-/' G \
|I Oﬁ 1 ‘ait 10 full seconds forthe load cell valie ta stabilze.
|
\ /

e M2L | 24549m 2456125

ML [ 245245 2450675
sL 2450000 2451225
wl | 2459800 2461025

i

‘:« f Stratasys [1¥alues aie stable

X Cancel

M-2 R
-1 0
SR

W R

Figure 6-54: Level stabilization

4. Select the Weight is stable check box, and click Next.
If you need to calibrate more than one load cell, the next calibration

screen appears. Repeat steps 3 and 4 until all of the load cells are

calibrated.
5. Click Done in the final wizard screen.

Load Cell Calibration Wizard
completed

that the drain tuke is not bent.

If you removed the waste cortainer, replace it and ensure

If, after calibrating the load cells, you suspect that they are
not accurately measuring the weight of the containers,

contact your Objzt service provider.

-/ stratasys

=

Figure 6-55: Final wizard screen
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Replacing the  The UV lamps used for curing models have a long, but limited, working

UV Lamps life. The Stratasys service engineer tests their effectiveness during regular
maintenance checks, and replaces them, if necessary. You can test and
adjust their effective power with the UV Calibration Wizard (see “Testing
and Calibrating the UV Lamps” on page 36. If you need to replace a UV
lamp, follow these instructions:

1. Make sure the printer is in offline mode.

Figure 6-56: Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be
red. If not, click it to switch the printer to offline mode.

. WARNING: Before continuing, make sure that the safety interlock is not
defeated, and that the lamp is not hot.

2. Start the UV Lamp Replacement Wizard from the Options menu (see
figure 6-24 on page 25).

3. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer cover and click Next.

UV Lamp Replacement Wizard

Inspect the build tray

Cenfirm be‘ore coniinuing:

[7] The buid tray iz claar [empty.

' stratasys

X Cancel

Figure 6-57: “Empty tray” confirmation screen

The axes move to the “home” position.
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4. Select the UV lamp(s) to be replaced and click Next.

Select the UV lamp(s) you wish to |
replace:

[] Right L Lanp
[ Left L% Lamp

' Stratasys

X Cancel

Figure 6-58: UV lamp selection screen

5. Disconnect the UV-lamp power connector and the UV heat fuse
connector.

Figure 6-59: Disconnecting the UV lamp

Note: Do not disconnect the power connection to the cooling fans.

6. Loosen the screw securing the UV lamp cover (A), and pull the cover
up (B), then out (C).

|

Figure 6-60: Removing the UV lamp cover
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7. Pull the lamp reflector out of the print block.

Figure 6-61: Removing the UV lamp reflector

8. Inspect the new lamp reflector, and make sure that a black strip is
attached to the inside of it. If not, install one—on the side of the
reflector opposite (not next to) the print block.

Note: Extra black strips are included in the printer Start-up Kit. If
necessary, you can remove the black strip from the old reflector and install
it in the new reflector (as long as the black paint has not faded).

9. Discard the old reflector and lamp.

Dispose of the used UV lamp in accordance with environmental and safety
requirements.

10. Insert the new UV lamp/reflector unit into the housing next to the print
block.

UV lamp
assembly_ . )

UV lamp
Ll assembly

I'. RTATRARRR R Y R E \-}__—Black strip
i S T y L—

Figure 6-62: Print block and UV lamp assembly, showing correct placement of
black strip
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11. Replace the lamp cover by inserting it into the slot on the bottom of the
housing, and tighten the securing screw on top.

—

)

Figure 6-63: Replacing the lamp cover

12. Reconnect the power and heat fuse connectors.

13. In the wizard screen, confirm that you have replaced the lamp(s) and
that the black strip is attached, then click Next.

UV Lamp Replacement Wizard

[ U lampls) replaced
[ Skadow bracket located conectly [see elp)

' Stratasys

2 Help

Figure 6-65: UV-installation confirmation screen
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The wizard operates the lamps and checks if their power is within the
acceptable range for each printing mode. (The mode currently being
checked appears in the lower-left corner of the printer interface.)

=" stratasys

Figure 6-66: Status screen during UV lamp check

14. After replacing a UV lamp, it is recommended that you calibrate its
power for the various printing modes. The final screen allows you to
continue to the UV Calibration Wizard (see “Testing and Calibrating
the UV Lamps” on page 6-36).

UV Lamp Replacement Wizard
completed

Do wiou weant to run the 'L calibration wizard' now?

1Mo

Figure 6-67: Final wizard screen
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Built-in Tests The printer application contains a suite of tests for regularly checking the
hardware and software, and for troubleshooting. You can configure basic
communications and environment tests to run automatically, when the
Objet software opens. In addition, you can run a more comprehensive set of
tests before processing a print job, as a system check, to ensure optimum
printing results.

Because running the tests effects the operation of the printer, you can only
open the Built-in Tests interface when the system is not printing.

The test suite features:

* The organization of printing-related tasks in categories:
Communications

Data cards

Temperatures

Voltages

Encoder repeatability

Qaooaoaaaq

Print-head heating
O Print-head filling

* A clear display of test results and the source of any failures, enabling
you to determine if printing is possible or worthwhile.

* The ability to monitor test results for specific components.
* Troubleshooting tips.

Running these tests can help identify problems in the printer hardware and
software. A large number of hardware defects (or near-defects) warns you
of possible printing problems, either for current or future jobs.

Stratasys recommends running the built-in tests in the following cases:
% * as aroutine test, once every two weeks
* as a system check, before major (long) jobs

* as needed, for troubleshooting

Accessing To open the Built-in Tests screen, do one of the following:

Built-in Tests  + prom the Options menu, select Built-In Tests.

* Press Ctri+Alt+B.
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Figure 6-68: Selecting Built-In Tests from the Options menu
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Test Interface

Test List

Test Selection Area

648

The Built In Tests screen lists pre-configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are
displayed.

Built In Tests
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O systemInta E v ranment ?
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== ] } 1
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[ All ] [ Naone | [Llnk-mwn] f-—Mone - v: |- Man= - W -

Figure 6-69: Built In Tests screen

Test Name

This column lists all of the tests, together with selection check boxes.
Click the check boxes to select the tests you want to run. To remove a
selection, click the check box again. To quickly select all of the tests in a
component category, use the Group pull-down menu at the bottom of the
screen.

Group

This column shows the component categories for each test.

This tells you which tests are run when selecting a category from the Group
pull-down menu at the bottom of the screen.

Status

This column shows the results of each test after you run it:

o  Test successfully completed.
X Test failed.

?  Unknown results. (The test has not been run yet.)

In the Test Selection area, at the bottom of the screen, you can quickly select
or de-select tests by their characteristics:

All Click to select all of the tests in the list.
None Click to de-select all of the tests in the list.
DRAFT DOC-06800 Rev. A
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Unknown

Click to select all test that have not been run yet (Status = ?).

Group

Use this menu to select tests by component category.

Selection
Set

Use this menu to select a pre-configured set of tests to run at
specified times (computer startup, before printing, etc.).

Running Tests To run the selected tests:

> Click [0 R |

After you run a test, the Save and View command buttons are added to the
Built In Tests screen (see below).

Test Results To save and view a report of all of the tests:

» Use the Save and View command buttons (see below).
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Command Buttons  You click the command buttons, on the right side of the screen, to perform

@ Run
@ Reset

LJ Save

A Misw

Summary

X

“E Help
ﬂ Close

Summary

6-50

the following operations:

Run

Click to run the selected tests.

Reset

Click to clear previously run tests. This returns the status of each test to
Unknown (?).

Save

Click to save a report that summarizes the tests run. The report is saved as
an HTML file. You can save any number of reports for the tests you run; the
name of the file saved is BITReport [date][time].htm. By default, these files
are saved in the Objet installation folder, but you can save it in any other

folder.
View

Click to display the latest test report that you saved. (You can view other
test reports by opening the relevant files in your Web browser. To do so,
open Windows Explorer, and double click the BITReport file.)

Close
Click to close the Built-in Tests screen.

On the right side of the screen, a symbol represents the combined results of
all the tests run, using the symbols from the Status column.

"  All tests successfully completed.
X  Atleast one test failed.

“?  Not all tests performed.
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Test Descriptions  The following table lists the name of each test in the Built-in Tests suite,

and

together with its description and a possible reason for its failure. If you

Troubleshooting need assistance, contact your Stratasys service provider.

Test Name Description Possible Reason for Failure
Sub-System Tests communications between Eden * Disconnected communications cable.
Communication components. * Faulty cable.
FIFO Non-Interrupt/ * Tests the data queue in the DATA ¢ If both FIFO tests fail:
FIFO Interrupt PCI card. Faulty DATA_PCI card.
* Tests the Windows interrupt. ¢ If only the FIFO Interrupt test fails:
Faulty Windows interrupt.
Encoder Tests the encoder's reliability by Faulty encoder.
comparing readings from multiple runs
along the X-axis.
System Info Compares the following parameter Failure of RAM memory allocation in the
values with the minimum printer computer.
requirements.
* physical memory
* available memory
* free space on disk
* monitor resolution
RFID Verifies the presence of RFID tags on all | ® Faulty RFID reader.
loaded cartridges, and tests them by * Faulty RFID reader power supply.
writing to and reading from each one. | ® Faulty or misaligned RFID tag.
* High level of electromagnetic noise
around the RFID tag.
System Voltages Checks if the following voltages are * VPP power supply:
within 5% of the required voltage: Faulty head drive(s).
* 40V to the print heads by the VPP | * VDD power supply:
power supply Faulty height thermistor(s).
® 12V to the height thermistors by the
VDD power supply
Block Filling Analyzes the thermistor readings when | Faulty thermistor.
the block is full and when it is empty.
Interlock Tests the interlock in the printer cover. | ® Failure of interlock mechanism.
* Faulty latch.
® Disconnected cable.
Cabin Temperature Tests the temperature level in the Faulty temperature sensor (OHDB).
build-tray area.
Head EEPROM Tests the read/write capabilities of the | Faulty print-head driver card(s).
print-head driver cards.
Head Voltage Checks the control of voltages supplied | Faulty print-head driver card(s).
to the print heads.
Tray Heater —
Head/Block Heaters Tests the heaters in the print heads and | Faulty heaters or thermistors.
in the print-block body.
UV Lamps Tests each UV lamp at the High Quality | Faulty UV lamp.
power level. Faulty UV power supply.
Disconnected UV cable.
Axes Limit Tests the hardware and software limits | Faulty hardware sensors.
of all axes. Wrong Max Position parameter.
Parameter Sanity Check| Compares the values of all printer One or more of the printer parameters is

parameters (in cfg files) to the required
values.

not within the required range.
Details appear in the BIT report.
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Test Name Description

Possible Reason for Failure
Vacuum

Tests the vacuum level in the print * Faulty vacuum sensor.
block.

* Vacuum leakage.
* Wrong parameters.

Ambient Temperature

Evacuation Sensor
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Replacing the
Waste
Container

R

Cleaning the
Exterior Panels

DOC-06800 Rev. A

Printer waste contains partially cured polymeric material, collected during
normal operation and maintenance of the printer. For safety and
environmental reasons, this material is kept in leak-proof containers.

monthsEach container has a capacity of 18 kilograms of waste material.
The printer software displays a warning message when one waste
container is full and there is XX kilograms of material in the other container.
The printer stops printing when the net weight in the second container
reaches XX kilograms. When the net weight in the second container is
above XX kilograms, the software does not allow you to start a print job (or
a printing activity) until you replace one of the waste containers. You can
monitor the weight of the waste containers in the printer interface.

Dispose of the full waste container in accordance with environmental and
safety requirements.

The painted exterior plastic panels of Objet 3D printers have a durable
finish, offering excellent chemical resistance to common cleaning materials.
However, it is recommended that you use only a mild soap solution for
routine cleaning.
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